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 Electronic mail: otm-doc_us@oracle.com 

If you have problems with the software, contact Support at https://support.oracle.com or find the 
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mailto:otm-doc_us@oracle.com
https://support.oracle.com/
https://www.oracle.com/support/contact.html
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Preface 

This document contains information regarding the installation of the following products: Oracle 
Transportation Management, Global Trade Management, and Fusion Transportation. This manual does 

not cover the installation of the operating system, any other Oracle components (e.g. the Oracle 
database or Oracle HTTP Server) or any third-party components (e.g. a third-party rating engine). 

Change History 

Date Document Revision Summary of Changes 

12/2017 -01 Updated agent configuration steps for ODI agent. 

Changed property “allow_advanced_analytics” to uppercase: 

ALLOW_ADVANCED_ANALYTICS. 

Modified FTI and GTI installation and configuration steps for 
OBIEE 12c. 

Added “Enabling Maps in OBIEE and FTI” section. 

Changed write back configuration steps for FTI. 

Added properties to support global currencies in FTI. 

Added an appendix with the list of reserved properties. 

Removed all references to BLUEPRINT users 

(BLUEPRINT.ADMIN and BLUEPRINT.DEFAULT). 

Removed product version requirements in favor of information 
in the OTM Technical Architecture Guide. 

Modified section Installing OTM on the Database Server” for 
6.4.3. 

Modified Minimum OS System Requirements. 

Removed Installation procedures for app server only install. 

Modified Web server installation to become Mid-Tier install. 

Where appropriate, replaced the words “custom”, 

“customizing”, “customized” with one of the following 
“configuration”, “configure”, “edit”, “update”, “user-defined”, 
or “customer-defined per Fusion requirements. 

Added FTI properties requirement for installation in “Creating 
Historical Database (HD), Users, and Packages” 
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Date Document Revision Summary of Changes 

12/2017 -01 Updated “Create OTM Database Structure and Public Data” 
section 

Standard Terminology for 6.4.3 Architecture Changes 

Removed specific patch version for Oracle DB PSU 

Updated ODI installer file name versions in installing ODI 

section. 

01/2018 -02 Removed section “Creating Business Intelligence Roles in 
OBIEE or OBIA” and its reference. 

07/2018 -03 Corrected typo in Table 3-1. ARCHIVE_C_LOB_TBS and  
ARCHIVE_C_TBS are now corrected to be ARCH_C_LOB_TBS 

and ARCH_C_TBS. 

05/2019 -04 Replaced “2 x 2.5 GHz quad-core Xeon CPU w/ 18 MB cache, 
16 GB RAM, 80 GB disk” with “Latest multi-core Intel 
processors with 32 GB RAM and 120 GB disk”. 

Removed text suggesting that you can install multiple 

instances of OTM using separate IPs but with the same ports. 

06/2019 -05 Updated Oracle Data Integrator version from 12.2.1.2.0 to 
12.2.1.3.0. 

07/2019 -06 Updated JDK version, Oracle Fusion Middleware Infrastructure 

versions, and links to Oracle Fusion Middleware and ODI docs. 

09/2020 -07 Replaced "12c" database references with "12c or higher". 

10/2020 -08 Updated Oracle Data Integrator version from 12.2.1.3.0 to 
12.2.1.4.0. 

10/2020 -09 Added a Note during create_all script execution on 19c DB or 
higher. See Installing OTM on the Database Server -> 
Create Tablespaces -> Create OTM Database Structure 
and Public Data. 
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1. Installation Requirements 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 
Architecture Guide. 

Oracle Enterprise Linux Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 
necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 

application (see the Oracle Transportation Management Security Guide for more info on Privileged 
Ports). The user that runs the installer must have full rights to the installation directory. 

Red Hat Linux 

Red Hat AS/ES 6 is also a supported platform, but OTM has not been certified on it. In this guide, 
wherever Oracle Enterprise Linux Server release 6 is referenced, simply replace it with Red Hat AS/ES 
6. Any Red Hat-only instructions will be clearly marked as such. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 

application. It does not take into account additional OTM components or third-party 
components and it is not a configuration for high volume or complex implementations. To 

determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 

plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 
Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Mid-Tier Server 

 Latest multi-core Intel processors with 32 GB RAM and 120 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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Software Requirements 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 
Architecture Guide. 

 64-bit Oracle Enterprise Linux Server with the latest recommended patches 

 Oracle Database Enterprise Edition 

o a standard installation is required 

 Oracle Fusion Middleware Infrastructure 

o Select the Fusion Middleware Infrastructure for the installation type. 

 Oracle Fusion Middleware HTTP Server  

o Install into the same directory you installed Oracle Fusion Middleware Infrastructure. 

o Select Colocated HTTP Server as the installation type 

 Integration Server - EAI solution (optional) 

The following additional software is distributed with OTM: 

 64-bit Sun JDK 1.8.x 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 12c or higher Database Client (Administrator install) has been installed and configured 

to connect to your database. 

 WebLogic Clustering database is installed and repositories created; see Creating the WebLogic 

Metadata Repository. 

Pre-Install Setup 

Update kernel parameters as needed for the Database Client. This is covered in the Oracle Database 
installation documentation. Restart the server. 

Installing Oracle Fusion Middleware prerequisite software on the Mid-Tier Server  

Install Oracle Fusion Middleware Infrastructure as per its documentation, using a 1.8.x JDK. Note the 

BEA Home directory (e.g. D:\product\bea) and the WL Home directory (e.g. 

D:\product\bea\wlserver). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Install Oracle Fusion Middleware HTTP Server as per its documentation, making sure to select the 

“Collocated HTTP Server” option. Note the BEA Home directory (e.g. /opt/bea) and the Oracle HTTP 

Server Home directory (e.g. /opt/bea/ohs). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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Note: Unlike in previous versions of OTM, an OHS instance does not need to be created 

prior to installing OTM. The OTM installer will now take care of this. 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.  

Solaris Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 

and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 
necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 

Ports). The user that runs the installer must have full rights to the installation directory. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 

application. It does not take into account additional OTM components or third-party 

components and it is not a configuration for high volume or complex implementations. To 
determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 
Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Mid-Tier Server – Solaris SPARC 

  1 x 3.6 GHz sixteen-core SPARC T5-2 w/8 MB cache, 16 GB RAM, 80 GB disk space. 

Note: For the database server, please see the documentation associated with that product. 

Mid-Tier Server – Solaris x86 

  Latest multi-core Intel processors with 32 GB RAM and 120 GB disk. 

Note: For the database server, please see the documentation associated with that product. 
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Software Requirements 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 
Architecture Guide. 

 64-bit Solaris with the latest recommended patches 

o Solaris 10: OTM supports both SPARC and x86 architectures 

o Solaris 11: OTM supports both SPARC and x86 architectures 

 Oracle Database Enterprise Edition 

o a standard installation is required 

 Oracle Fusion Middleware Infrastructure 

o Select the Fusion Middleware Infrastructure for the installation type. 

 Oracle Fusion Middleware HTTP Server 

o Install into the same directory you installed Oracle Fusion Middleware Infrastructure. 

o Select Colocated HTTP Server as the installation type 

 Integration Server - EAI solution (optional) 

 

The following additional software is distributed with OTM: 

 64-bit Sun JDK 1.8.x 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 12c or higher Database Client (Administrator install) has been installed and configured 

to connect to your database. 

 WebLogic Clustering database is installed and repositories created; see Creating the WebLogic 

Metadata Repository 

Pre-Install Setup 

Update kernel parameters as needed for the Database Client. This is covered in the Oracle Database 

installation documentation. Restart the server. 

Installing Oracle Fusion Middleware Prerequisite Software on the Mid-Tier Server 

Install Oracle Fusion Middleware Infrastructure as per its documentation, using a 1.8.x JDK. Note the 

BEA Home directory (e.g. /opt/bea) and the WL Home directory (e.g. /opt/bea/wlserver). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Install Oracle Fusion Middleware HTTP Server as per its documentation, making sure to select the 
“Collocated HTTP Server” option. Note the BEA Home directory (e.g. /opt/bea) and the Oracle HTTP 
Server Home directory (e.g. /opt/bea/ohs). 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

Note: Unlike in previous versions of OTM, an OHS instance does not need to be created 

prior to installing OTM. The OTM installer will now take care of this. 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation.  

Windows 2012 Server Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of Windows-based applications. It is also recommended that you have an 
administrator familiar with the creation and support of Oracle Database instances. A Network 

Administrator may be necessary at times, especially during the configuration of systems that will be 
accessed through firewalls, VPN, etc. 

You must be logged in as Administrator or someone with Administrative privileges to install OTM 
successfully. 

Minimum Hardware Requirements 

Note: This section only details the minimum hardware required to run the base OTM 
application. It does not take into account additional OTM components or third-party 

components and it is not a configuration for high volume or complex implementations. To 

determine the correct configuration for your production, test, and development 

environments, you should work with your hardware and/or implementation consultants. 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture Guide for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 
system version, available memory, hard drive speed, network card speed, and network bandwidth 

between the browser and the web server. 

Note: Popup Blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 
Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-

Viewer.aspx. 

Mid-Tier Servers 

 Latest multi-core Intel processors with 32 GB RAM and 120 GB disk. 

Note: For the database server, please see the documentation associated with that product. 

Software Requirements for OTM Server Configurations 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 
Architecture Guide. 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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 64-bit Windows Server Datacenter Edition with the latest Service Packs, OR 

 64-bit Windows Server Standard Edition with the latest Service Packs, OR 

 Oracle Database Enterprise Edition 

o a standard installation is required 

 Oracle Fusion Middleware Infrastructure. 

o Select the Fusion Middleware Infrastructure for the installation type. 

 Oracle Fusion Middleware HTTP Server 

o Install into the same directory you installed Oracle Fusion Middleware Infrastructure. 

o Select Colocated HTTP Server as the installation type 

 Integration Server - EAI solution (optional) 

 

The following additional software is distributed with OTM: 

 64-bit Sun JDK 1.8.x 

Preparing to Install OTM 

Before you begin the installation process, ensure that the following is already complete: 

 A compatible operating system is installed (see above) and configured for high performance. 

 Virtual memory is set to 1.5 to 2 times the amount of physical memory in the system. 

 All OTM server machines are time-synced using a process like NTP. This is critical to the 

proper operation and troubleshooting of an OTM instance. 

 Oracle 12c or higher Database client (Administrator install) has been installed and configured 

to connect to your database. 

 WebLogic Clustering database is installed and repositories created; see Creating the WebLogic 

Metadata Repository 

Installing Oracle Fusion Middleware Prerequisite Software on the Mid-Tier Server 

Install Oracle Fusion Middleware Infrastructure as per its documentation, using a 1.8.x JDK. Note the 

BEA Home directory (e.g. D:\product\bea) and the WL Home directory (e.g. 

D:\product\bea\wlserver). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Install Oracle Fusion Middleware HTTP Server as per its documentation, making sure to select the 

“Collocated HTTP Server” option. Note the BEA Home directory (e.g. D:\product\bea) and the Oracle 

HTTP Server Home directory (e.g. D:\product\bea\ohs). 

Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

Note: Unlike in previous versions of OTM, an OHS instance does not need to be created 

prior to installing OTM. The OTM installer will now take care of this. 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation. You must be 
logged in as Administrator or someone with Administrative privileges to install OTM successfully. 
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AIX Installation Requirements 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of UNIX based applications. Also, it is recommended that you have an administrator 
familiar with the creation and support of Oracle Database instances. A Network Administrator may be 

necessary at times, especially during the configuration of systems that will be accessed through 
firewalls, VPN, etc. 

You must run the installer as a non-root user, though root access may be required to start the 
application (see the Oracle Transportation Management Security Guide for more info on Privileged 
Ports). The user that runs the installer must have full rights to the installation directory. 

Minimum Hardware Requirements 

Web User 

You must have a computer capable of running one of the supported browsers (see the Oracle 
Transportation Management Technical Architecture document for a list of supported browsers). Many 
factors will affect the performance experience of the end-user, including: CPU type & speed, operating 

system version, available memory, hard drive speed, network card speed, and network bandwidth 
between the browser and the web server. 

Note: Popup blockers may prevent your browser from working correctly with OTM. If you 

experience any problems, try disabling them before contacting Technical Support. 

Note: If you want to view the results generated by the Load Configuration feature, a VRML 
plug-in for your Web Browser is needed. OTM has been tested with the Cortona plug-in for 

Internet Explorer, available at: www.cortona3d.com/Products/Viewer/Cortona-3D-
Viewer.aspx. 

Test, Development and Production Servers 

Please consult the hardware vendor for more information on hardware sizing. 

Software Requirements 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 
Architecture Guide. 

 64-bit AIX with the latest recommended patches 

o Korn shell linked to /bin/ksh 

o Bash shell linked to /bin/bash 

 Oracle Database Enterprise Edition 

o a standard installation is required 

 Oracle Fusion Middleware Infrastructure 

o Select the Fusion Middleware Infrastructure for the installation type. 

 Oracle Fusion Middleware HTTP Server 

o Install into the same directory you installed Oracle Fusion Middleware Infrastructure. 

o Select Colocated HTTP Server as the installation type. 

 Integration Server - EAI solution (optional) 

 Java 1.8 JDK 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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Preparing to Install OTM 

Before you begin the installation process, ensure that the following is complete: 

 A compatible operating system is installed (see above) along with any patch bundles 

recommended by the OS vendor. 

 The size of the swap space on your server is equal to or greater than the amount of memory it 

contains. 

 All OTM servers are time-synced using a process like NTP. This is critical to the proper 

operation and troubleshooting of an OTM instance. 

 Oracle 12c or higher Database Client (Administrator install) has been installed and configured 

to connect to your database. 

 Java Development Kit 1.8+ (see note below). 

 WebLogic Clustering database is installed and repositories created; see Creating the WebLogic 

Metadata Repository 

Java Development Kit (JDK) 

Oracle does not provide a JDK for this platform, but it is necessary to run the application; this will 
need to be obtained by you and installed onto the system prior to OTM being installed. A full JDK is 

required; a simple Java Runtime Environment (JRE) will not suffice. The installation directory for the 
JDK will need to be supplied to the OTM installer. Although the OTM installer will check to make sure 
the programs exist and are executable, it will not check that the correct version is installed. The 
application will fail to run unless the proper JDK version is supplied. The OTM installer will create a 
symbolic link from this supplied directory to one name “jdk” inside of the OTM install directory. 

Note: Unlike other JDK vendors, IBM does not ship a library needed by the application. For 

each web server, after the completion of the OTM, do the following: 

1. Go to http://jaxp.java.net and download JAXP 1.4.6 

2. Extract the contents of the JAR file, e.g.: 

$ CLASSPATH= java –jar JAXP_146.jar 

3. Get the jaxp-ri.jar file from the lib directory and copy it to the 

<otm_install_dir>/glog/gc3webapp/WEB-INF/lib/3rdparty directory 

4. Proceed with the standard application installation. 

Pre-Install Setup 

1. Update kernel parameters as needed for the Database Client. This is covered in the Oracle 

Database installation documentation. Restart the server. 

Installing Oracle Fusion Middleware Prerequisite Software on the Mid-Tier Server 

Install Oracle Fusion Middleware Infrastructure as per its documentation, using a 1.8.x JDK. Note the 

BEA Home directory (e.g. D:\product\bea) and the WL Home directory (e.g. 

D:\product\bea\wlserver). 

Note: The user that OTM runs as must have read access to the WebLogic install directory 

and all of its sub-directories. 

Install Oracle Fusion Middleware HTTP Server as per its documentation, making sure to select the 

“Collocated HTTP Server” option. Note the BEA Home directory (e.g. /opt/bea) and the Oracle HTTP 

Server Home directory (e.g. /opt/bea/ohs). 
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Note: The user that OTM runs as must have read access to the Oracle HTTP Server install 

directory and all of its sub-directories. 

Note: Unlike in previous versions of OTM, an OHS instance does not need to be created 

prior to installing OTM. The OTM installer will now take care of this. 

Installing OTM 

Follow the instructions in the Installing OTM chapter to finish your OTM installation. 
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2. Installing OTM 

It is HIGHLY recommended that you make available personnel who are familiar with the installation 
and configuration of Windows or UNIX based applications (depending on operating system you are 

installing on.) Also, we recommend that, in the case of the Oracle Database, that you have on hand an 
administrator familiar with the creation and support of Oracle Database instances. A Network 
Administrator may be necessary at times – especially during the configuration of systems that will be 
accessed through firewalls, VPN, etc. 

Note: Sections below that contain operating system-specific options are marked with 

[AIX], [Linux], etc. 

Multiple Products, Single Installer 

The Oracle Transportation Management installer can be used to install many different products, 
depending on what software you have licensed. These products can be broken into the following broad 
family groups: Oracle Transportation Management and Global Trade Management. All of these product 
families, and the products under them, share a single installer binary and you will be prompted to tell 
the installer which product you will be installing. Unless specifically noted, all options below pertain to 
all products. 

Note: Sections below that contain product-specific options are marked with [OTM], 

[GTM], or some combination thereof. 

Because of the universal nature of the installer, file names, directory names, window titles and the like 
may only reference a single product (i.e. Oracle Transportation Management) however they will apply 
to all products unless otherwise indicated.  

Explanation of Application Layers 

Any given instance of Oracle Transportation Management or Global Trade Management is made up of 
many sub-components that can be grouped into the following “layers”: 

 Database layer: where the data actually resides 

 Mid-Tier Layer: 

o Web Server layer: the OHS component servicing client HTTP requests. 

o Application Server layer: the WebLogic instance hosting both our UI, via the servlet 

engine, and backend, via J2EE. 

Note: Starting with OTM 6.4.3, the Application and UI layer have been integrated into a 

single App server layer. 

Note: Starting with OTM 6.4.0, a WebLogic Clustering database is required for the Web 

layer. For security reasons it is highly recommended that this database be separate from 

the database where the product data resides. Please see the Oracle Transportation 

Management Security Guide for more information. 

 Fusion Transportation Intelligence: where Oracle Business Intelligence Enterprise Edition 

(OBIEE) and Oracle Data Integrator (ODI) run 

 Integration layer: where incoming XML data is handled 

o This is just a normal web instance that you designate as being used for handling 

integration in addition to, or instead of, handling normal user traffic; please see the 
Oracle Transportation Management Integration Guide and the Oracle Transportation 

Management Data Management Guide for alternatives to using web-layer integration. 
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o Whether or not a given web instance is handling user traffic is as simple as whether or 

not users know to access the instance. In order to set up a separate integration web 

server, your upstream processes simply need to know where to send data to and your 

users should not be directed to use it. 

Recommended Installation Configurations 

The application can be installed in various configurations to provide scalability for production 
instances, or to provide for consolidation of system resources for test/development instances. 

Oracle Transportation Management/Global Trade Management 

Production instances of any Oracle Transportation Management or Global Trade Management will 

normally run each of the above component layers on separate servers. For instance, we would see the 
following configuration: 

 Server One: Database layer 

 Server Two: Mid-Tier layer (including the WebLogic Clustering database) 

 Server Three: Integration layer 

 Server Four: Oracle Fusion Transportation Intelligence layer 

 

Test instances can be consolidated onto fewer servers, depending on the hardware availability within 
your organization. Commonly, we will see the following configuration for test instances: 

 Server One: Database and Oracle Fusion Transportation Intelligence (FTI) layers 

 Server Two: Mid-Tier and Integration layers 

If the test server has enough resources (Memory/CPU), it is possible to run everything on a single 

system. This should ONLY be done for test instances and is NOT recommended for any production 

level use. Please contact Technical Consulting if you have any questions. 

Upgrading From a Previous Version 

Prior releases of Oracle Transportation Management provided two installers, an “upgrade” installer and 
a “fresh” installer. The upgrade installer was used to install the new version of the software on top of 
an earlier version of the software, whereas the fresh installer laid down the latest code into a new 
directory. Either installer allowed for the migration of administrator-defined properties from an earlier 

release. 

As of version 6.3 there is no longer an upgrade installer provided. Instead, the process of upgrading 
from a prior version is to lay down new code into a new directory and then copy any configurations 
from your previous installation into the new installation. See the “Migrating Configurations” chapter in 

the Oracle Transportation Management Migration Guide for the specific steps. 

After configurations have been migrated the database needs to be migrated. Please refer to the Oracle 
Transportation Management Migration Guide for further details. 

When migrating from OTM 6.4.2, it is critical that the wallet be copied so that it is available to the 
installer and follow the directions in the “Specifying a Wallet Home” directions for when there is 
existing wallet. 

Important Note: As of version 6.3.1, database connections are made via Service Names instead of 
database SIDs. If you are upgrading from a previous version, you should ensure that the Service 
Name for their database is the same as the SID; if it’s not, make sure to use the correct value. 
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Creating the WebLogic Metadata Repository 

As of release 6.4.0, OTM now requires access to a WebLogic Metadata Repository using MetaData 
Services (MDS) on the Web Server layer. The MDS repository is a database that stores metadata 
information for Oracle Fusion Middleware components, in this case Oracle HTTP Server (OHS), and 

needs to be seeded with specific schemas using the Oracle Fusion Middleware Metadata Repository 
Creation Utility (RCU). The requirements for the database along with instructions on how to run the 
RCU program can be found in the WebLogic documentation.  

1. When the RCU program is run, select “System Load and Product Load” on the “Create 

Repository” step.  

2. On the “Select Components” screen, select “Oracle AS Repository Components” and “Create 

New Prefix”.  

3. Make note of the prefix supplied along with all of the schema names and passwords supplied. 

 

Specifying a Wallet Home 

As of release 6.4.2, OTM stores all external passwords in two secure wallets: 

 a reserved wallet, “wallet.shared”, holding passwords critical to OTM component 

communication. This includes database and WebLogic passwords needed for the Mid-Tier 

server to startup correctly. 

 a user wallet, “wallet.otm”, holding passwords needed by external systems, report systems, 

content management systems and web services.  

To ensure passwords are synchronized across all Mid-Tier servers, these servers need to access a 

single, shared wallet home. In addition this access must be read/write for all Mid-Tier systems running 
OTM to function properly. 

 UNIX systems can use Network File Sharing (NFS) where each server mounts the shared 

wallet home to a local path. This path is then specified during installation as the wallet home. 

 Windows systems can use Sharing permissions to allow all servers to access a common wallet 

home. 

For new installations, the installer creates an empty reserved and user wallet. It populates the 
reserved wallet with passwords specified during the installation process. When installing optional 
components, passwords are staged in the Property Set screen. This screen delegates password 

storage to the wallets. 

For customers migrating existing wallets, the wallets should be copied into the wallet home prior to 
running the installation. The installer updates passwords in the reserved wallet as needed; passwords 
in user wallet are respected. This is critical as references in various tables like EXTERNAL_SYSTEM 
refer to entries in the user wallet. 

Installer Interface Options 

Depending on the operating system, OTM can be installed using one of three options: GUI, Console, 

and Silent. All installation capabilities are available with all interface options; it’s simply a matter of 
preference and convenience in deciding which one to use. 

GUI Interface 

The GUI option is available on all platforms. It uses the native windowing system (e.g. X11) to interact 
with the user. Under Unix/Linux systems, this requires you to have an X display running, and to have 
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the DISPLAY environment variable set correctly. Contact your local System Administrator if you need 

help setting this up. To use this interface, simply run the installer executable with no further options: 

$ ./otmv643_<platform>.bin 

Console Interface 

The Console interface option is available on all platforms except Windows. It runs on the command 
line and interacts with the user through a text-only interface. To use this interface, run the installer 
executable with a single option: 

$ ./otmv643_<platform>.bin –i console 

Silent Installer  

The Silent Installer interface option is available on all platforms except Windows. A file is prepared 
ahead of time answering all of the questions that the installer would normally ask. The installer will 
read it in when it executes and then run completely hands-free. To use the silent installer option, run 

the installer executable with two options, one to select the silent interface and one to specify the 
response file to use:  

$ ./otmv643_<platform>.bin –i silent –f installer.properties 

Installing with the Silent Installer 

Before installing OTM with the silent option, you must locate, rename, and edit the response file. It is 

called example.installer.properties and is located in the same directory as the installer 

executable itself. 

1. Make a copy of example.installer.properties and save it to a new name (e.g. 

installer.properties). 

2. Edit the new file and fill in the answers as appropriate for your environment. All values are 

documented in the file itself. Note that some sections are only for certain platforms; all should 

be clearly marked. 

3. Run the installer executable from the command line with the following options: 

$ ./otmv643_<platform>.bin –i silent –f installer.properties  

where <platform> is the name of the platform you are on and installer.properties is the 

name of the file that you edited in the previous step. 

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error 

if there is not sufficient room there for the installer to extract itself. If you need to change 

this directory you must set the IATEMPDIR environment variable: 

$ export IATEMPDIR=/some/other/temp/directory 

$ ./otmv643_<platform>.bin –i silent –f installer.properties 

4. Once the installer has finished (up to 30 minutes, depending on your operating system and 

hardware) you should see the message: 

Installation Complete. 

Check the bottom of the installation log file, Oracle_OTM_v6.4.3_GA_InstallLog.log, for any 

errors or warnings (this file should be located in the directory that OTM was installed to). If 
there are any errors, please correct them (they should be self explanatory). If you find that 
you need help, please have the log file handy, along with the Exit Code (found in the log file), 
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before contacting Oracle Support. If you do not get the “Installation Complete.” message or 

cannot find the log file, look for a file of the same name in your home directory (i.e. 

$HOME/Oracle_OTM_v6.4.3_GA_InstallLog.log). 

5. Please refer to the sections at the end of Installing Interactive on the Mid-Tier Server for 

further post-install activities that need to be done before you can start up the application. 

Note: The silent installer response file contains sensitive information that should be 

safeguarded appropriately. 

Installing Interactively  

Note: Paths shown in this section will be in UNIX format (Ex. /opt/gc3) but should be in 

Windows format for Windows installs (Ex. D:/gc3 or D:\gc3). All directions are generic 

across all operating systems unless explicitly noted. 

1. Start the installer in GUI or console mode, as directed in the section above. 

Note: On UNIX/Linux systems, the installer extracts to /tmp, and you will receive an error 

if there is not sufficient room there for the installer to extract itself. If you need to change 

this directory you must set the IATEMPDIR environment variable: 

$ export IATEMPDIR=/some/other/temp/directory 

$ ./otmv640_<platform>.bin –i console 

Read the installation notice and click Next. 

Note: Console and GUI installations will have different prompts to continue. GUI installs 

will have a “Next” button, where console installations will ask you to “Hit enter to 

continue.” Please take the appropriate actions for the remaining steps. 

2. Choose the installation directory (e.g. /opt/otm or /opt/otm643 to denote version). If you are 

installing more than one OTM instance on a server, each instance must be installed into a 

different directory. 

3. Read the instructions for filling out the required data and click Next. 

4. BEA Home 

a. Enter the full path of the base BEA install directory (e.g. /opt/bea). 

b. Enter the full path of the base WebLogic install directory (e.g. /opt/bea/wlserver). 

This is usually under the BEA install directory. 

c. Click Next. 

5. Wallet Information 

a. Answer YES or NO to whether a wallet directory exists from a previous 6.4.2 

installation. 

6. Wallet Directory 

a. Enter the directory where the wallet should be created. Please see Specifying a Wallet 

Home section above. 

7. OTM Web/App User and Group 

a. Enter the name of the user to be used for Web <-> App communication (e.g. 

OtmAppUser). This user is an internal user, and is not one that can log into an 

interactive session in OTM. This must match the value entered during the OTM App 

Server installation. 

b. Enter the group name for the user (e.g. OTMApp). This must match the value entered 

during the OTM App Server installation. 

c. Click Next. 
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8. [AIX only] External JDK 

a. Enter the path to your Java Development Kit (see Preparing to Install OTM above) 

b. Click Next. 

9. OTM Internal URL Protocol 

a. Enter the Web Server Server Internal URL Protocol (DEFAULT: https). This would be 

the protocol used by the internal web server. By default the https option is configured. 

10. OTM External URL Protocol 

a. Enter the Web Server External URL Protocol (DEFAULT: https). If your site were 

accessed through a load-balancer or NAT device, this would be the protocol used in 

the external URL (outside your network). If not, then this would be the protocol used 

by the internal web server. By default the https option is configured. 

Note: For https installations a valid certificate and keystore will need to be 

configured and information supplied in later steps. Also, when  

creating the OHS wallet via the orapki utility the "-compat_v12" option should be 

used to enable the creation of a Java keystore from the OHS wallet. 

11. General Settings 

a. Enter the Web Server External Fully Qualified Domain Name (e.g. otm.oracle.com). 

This would work if ‘otm’ is the server name and ‘oracle.com’ is the domain name. If 
your site were accessed through a load-balancer or NAT device, this would be the 

external URL (outside your network). If not, then this would be the FQDN of your Web 

server from within your network. Please contact your Network Administrator if you 

have any questions about this. 

b. Enter the Web Server External Port. If your site is accessed through a load-balancer or 

NAT device, this is the external port. If not, then this is the port of your web server (in 

which case see the note below for more information on what this value should be). 

c. Click Next. 

12. General Settings (continued) 

a. Enter the Web Server Fully Qualified Domain Name. This may or may not be the same 

as the Mid-Tier Server External FQDN. 

b. Enter the Web Server Port. This will be the port that Oracle HTTP Server (OHS) is 

listening on, and will be used by end-users. This should be a number greater than 

1024 (see the “Admin Privileges” section of the Oracle Transportation Management 

Security Guide). 

c. Click Next. 

13. General Settings (continued) 

a. Enter the Database Server Fully Qualified Domain Name that is the name of your 

database server and the domain name (e.g. otmdb.oracle.com).  

b. Enter the Database Server Port. This is usually 1521. 

c. Enter the Database Connect String. This is the DB connect string as setup in your 

tnsnames.ora file under the Oracle client installation. Contact your Oracle 

Administrator for this information.  

d. Enter the Database Service Name. This may or may not be the same as the Connect 

String; contact your Oracle Administrator for this information. 

e. Enter Oracle Home Path where you installed the Oracle client  

f. Click Next. 

14. General Settings (continued) 

a. Enter SMTP Server Fully Qualified Domain Name. This server name is necessary to 

send email notifications from within OTM. Please contact your Network Administrator 

for this information. 
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b. Enter the Default Reply-To Email Address that all email notifications will appear to 

come from. This must map to a real mailbox and will allow you to check for bounced 

messages or delivery failures. 

c. Click Next. 

15. Mid-Tier Server WebLogic Domain Settings 

a. Enter the Mid-Tier server’s WebLogic domain name. Please see WebLogic 

documentation for valid values. This name must be unique for the WebLogic 

installation. 

b. Enter the Mid-Tier server’s WebLogic Server Port. This must be a unique port for the IP 

address it’s bound to. 

c. Enter the Mid-Tier server’s WebLogic SSL Server Port. This must be a unique port for 

the IP address it’s bound to. 

d. Enter the Mid-Tier server’s WebLogic Node Manager Port. This must be a unique port 

for the IP address it’s bound to. 

e. Click Next. 

16. MDS Repository Settings 

a. Enter the Database Server Fully Qualified Domain Name for the database housing the 

MDS repository. 

b. Enter the Database Server Port for the database housing the MDS repository. This is 

usually 1521. 

c. Enter the Database Service Name for the database housing the MDS repository; 

contact your Oracle Administrator for this information. 

d. Enter the Repostiory Prefix to be used for this install. This must be unique within the 

database. 

e. Click Next. 

17. MDS Database Settings (continued) 

a. Enter the Username for the MDS STB Schema. This usually includes the repository 

prefix and must be unique within the database. 

b. Enter the Username for the MDS OPSS Schema. This usually includes the repository 

prefix and must be unique within the database. 

c. Enter the Username for the MDS IAU Viewer Schema. This usually includes the 

repository prefix and must be unique within the database. 

d. Enter the Username for the MDS IAU Append Schema. This usually includes the 

repository prefix and must be unique within the database. 

e. Enter the Username for the MDS MDS Schema. This usually includes the repository 

prefix and must be unique within the database. 

f. Click Next. 

18. Mid-Tier Web Server Settings 

a. Enter the Mid-Tier Web Server SSL Port (usually 4444). 

b. Enter the Mid-Tier Server Host Name. For security reasons, it is recommended to use 

‘localhost’, so that only the WebLogic process can access it. 

c. Enter the Mid-Tier Server IP Address. Apache will be bound to this IP address. If you 

are installing more than one OTM instance on a server, each instance must be bound 
to a different IP address. Please contact your Network or UNIX Administrators for more 

information on creating virtual IP addresses within a server. 

d. Enter the Servlet Container Memory in Megabytes. This is the amount of system 

memory that the WebLogic Servlet Container will use. This is 4096MB by default, but 

may be higher or lower, depending on your configuration.  
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Note: If this value is lower than 4096MB, WebLogic may not start. Also, please be sure to 

note whether this server will be used for test/development or production, and what system 

resources it has available. 

e. Enter the Mid-Tier Server Launcher Port. This is 32000 by default. The Launcher binds 

to localhost (127.0.0.1). 

f. Click Next. 

19. Mid-Tier Web Server Settings (continued) 

a. Enter the OHS Component Name that you would like to use. This value must be 

unique within the WebLogic Domain Name. 

b. Enter the OHS Port. This is for the default OHS page, and is usually 7777. 

Note: This cannot be the same port used for Mid-Tier Web Server Port.  

c. Enter the OHS SSL Port. This is for the default OHS page, and is usually 4443. 

d. Enter the OHS Admin Port. This must be a unique port for the IP address it’s bound to, 

and is usually 9999. 

e. Click Next. 

20. [Windows only] Mid-Tier Server Settings: Service Name 

a. Enter the name that you’d like to use for the OTM Mid-Tier Server Service name (e.g. 

otm643). This name must be unique across all services for a given server. 

b. Enter the name that you’d like to use for the OTM Mid-Tier Server Node Manager 

Service name (e.g. otm_NM). This name must be unique across all services for a given 

server. 

c. Click Next. 

21. [AIX only] Web Server Settings (continued) 

a. Enter the number of logical CPUs in the server. This is used to set a JVM performance 

parameter. 

b. Click Next. 

22. HTTPS Settings 

a. Enter Identity KeyStore File Location for Mid-Tier Server. This will be the full path to 

the Identity Keystore file. 

b. Enter Trust KeyStore File Location for Mid-Tier Server. This will be the full path to the 

trust Keystore file. 

c. Enter the Private Key Alias for Mid-Tier Server.  

d. Enter the OHS Wallet Directory location 

23.  Mid-Tier WebLogic Admin Password 

a. Enter the Web tier WebLogic password for the ‘weblogic’ user. See the Oracle 
Transportation Management Security Guide for more information regarding the 

password requirements. 

b. Click Next. 

24. App-to-Web Authentication Password 

a. Enter the password for authenticating App-to-Web communication. This is the same as 

the OTM App User password. See the Oracle Transportation Management Security 

Guide for more information. 

b. Click Next. 

25. Guest Password 

a. Enter the guest user’s user password. See the Oracle Transportation Management 

Security Guide for more information. 

b. Click Next. 
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26. GLOGDBA Database User Password 

a. Enter the password for the database user ‘glogdba’. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

27. GLOGLOAD Database User Password 

a. Enter the password for the database user ‘glogload’. See the Oracle Transportation 

Management Security Guide for more information.  

b. Click Next. 

28. ARCHIVE_C_USER Database User Password 

a. Enter the password for the database user ‘ARCHIVE_C_USERS’. See the Oracle 

Transportation Management Security Guide for more information. 

b. Click Next 

29. MDS STB Schema Password 

a. Enter the MDS STB Schema user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

30. MDS OPSS Schema Password 

a. Enter the MDS OPSS Schema user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

31. MDS IAU Viewer Password 

a. Enter the MDS IAU Viewer Schema user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

32. MDS IAU Append Password 

a. Enter the MDS IAU Append Schema user password. See the Oracle Transportation 

Management Security Guide for more information. 

b. Click Next. 

33. MDS Schema User Password 

a. Enter the MDS Schema user password. See the Oracle Transportation Management 

Security Guide for more information. 

Click Next. 

34. Identity KeyStore Password for Web Server 

a. Enter the Identity KeyStore Password used when creating the keystore. 

35. Trust Keystore Password for App Server 

a. Enter the Trust Keystore Password used when creating the keystore. 

36. Private Key Password for Web Server 

a. Enter the private KeyStore Password used when creating the keystore. 

37. [UNIX Only] UNIX Settings 

a. Enter the user name that the OTM programs will run under (e.g. otm or otm640). 

b. Enter the group name that the OTM programs will run under (e.g. otm or otm640). 

c. Click Next. 



Copyright © 2001, 2020, Oracle and/or its affiliates. All rights reserved. 2-10 

Note: The installer will try to verify the user and group names that you enter against the 

/etc/passwd and /etc/group files. If the installer cannot verify these names (e.g. you 

mistyped them or you use something like LDAP or NIS to manage users and groups on this 

server), you will be prompted to correct them or validate that they are correct and continue 
with the installation. Similarly, the installer will use the /etc/passwd file to look up the 

home directory of the user you entered; if it cannot determine what the home directory is 

or cannot locate the actual directory, you will be prompted to correct it or verify that it is 

accurate and continue the installation. 

38. [UNIX Only] UNIX Settings (continued) 

a. Enter the home directory of the user specified previously. 

b. Click Next. 

39. Migration Custom Properties 

a. Choose whether or not to migrate configured settings from a previous OTM installation 

(3.7 or later). If you answer yes, you’ll need to choose the directory where your old 

glog.properties file is located.  

b. Click Next. 

40. Work Bench Migration 

a. Choose whether or not you will like to perform a workbench migration from another 

instance. Please see the OTM migration guide for further details. 

If the Installation of OTM Mid-Tier Server Fails 

If the installation of the OTM Mid-Tier server fails at any point there is currently no option to recover 
without reinstallation. You will need to stop all running services, remove the failed installation and 

restart the installation procedures. 

1. If running, stop the server’s WebLogic instance and the OHS component. 

a. You may be able to use the web server scripts (e.g 

/opt/otm/install/webserver/glogweb-wl stop). 

b. You may need to manually kill these processes. 

2. If running, stop the Node Manager that is automatically started as part of the installation 

process  

a. Run the stopNodeManager.sh script located in the web server’s WebLogic domain bin 

directory  (e.g. /opt/bea/user_projects/domains/otm/bin). 

3. Remove the installation directory (e.g. /opt/otm)and the web server’s WebLogic domain (e.g. 

/opt/bea/user_projects/domains/otm) 

4. If present, delete the entry for the failed WebLogic domain from the domain-registry.xml file 

(e.g. /opt/bea/domain-registry.xml). 

5. Remove and recreate the MDS schema by using the RCU utility. 

Startup Scripts (UNIX Only) 

A generic startup script is provided for your use: 

$OTM/install/webserver/glogweb-wl 

This can be used as-is or modified however you’d like to meet your organization’s specific needs. It is 
recommended that you make a copy of script before making any changes, so that the original is 

always available for comparison. Note that this script is capable of being used in most /etc/init.d-

type automatic startup environments. 



Copyright © 2001, 2020, Oracle and/or its affiliates. All rights reserved. 2-11 

Note: As of OTM 6.4.3, there is a single script (glogweb-wl) to start all of OTM as the Web 

and Application server are a single Mid-Tier installation. 

Installing More Than One Instance of OTM on a Single Server 

Oracle does not support installing more than one version of OTM onto a single server (or virtual 

server) unless each instance is bound to a different IP address. This can be accomplished by having 
separate network cards, each with their own IP address, or using virtual IP addresses. Please contact 
your System Administration team for the configuration and maintenance of this. 

Configuration and Log Files 

Information on the various configuration files and logging options has been move to the Oracle 
Transportation Management Security Guide. 

Starting & Stopping OTM Servers 

Please see the section “Starting & Stopping Oracle Transportation Management Servers” in the 
Administration Guide. 
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3. Installing OTM on the Database Server 

You should have your Database Administrator install the Oracle database and fine-tune it for 
performance. Once Oracle is installed, follow these steps to complete the process. 

These steps outline the procedures to set up an Oracle database for OTM. It requires that Oracle 
Database Server 12c or higher be installed and be patched with the latest recommended patch 
updates and an Oracle database be created. Please note that the OTM database scripts are located 
under <otm_install_path>/glog/oracle/script8 on the OTM Application server.  

Requirements 

All software and hardware requirements are listed in the Oracle Transportation Management Technical 

Architecture Guide. 

Oracle Options: Jserver, JAccelerator, Partitioning Oracle Instance Character Set:
 UTF8  (NLS_CHARACTERSET AL32UTF8) 

Note: It is recommended to have the latest PSU patch on top of the 12c or higher 

database. 

Initial Parameters 

The following initial parameters must be set:  

Open_cursors = 3000 (or greater) 

Processes = 3000 

Please refer to the init.ora file in <otm_install_path>/glog/oracle/script8 for recommendations 

on other parameters. 

Create Tablespaces 

The following tablespaces are required to be created first. As the database grows, more datafiles 
should be added to accommodate the application. For performance purposes, all tablespaces should be 
on different physical disks (if available) or on RAID 0+1 storage.  

Required Tablespaces for OTM Database 

Table 3-1: Required Tablespaces for OTM Database 

Tablespace Initial File Size 

ARCH_C_TBS 1 GB 

ARCH_C_LOB_TBS 1 GB 

DATA  5 GB 

INDX 5 GB 

REPORT 1 GB 

http://www.oracle.com/technetwork/documentation/glog-101972.html
http://www.oracle.com/technetwork/documentation/glog-101972.html
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Tablespace Initial File Size 

REPORTINDX 1 GB 

BPL_DAY1 1 GB 

BPL_DAY2 1 GB 

BPL_DAY3 1 GB 

BPL_DAY4 1 GB 

BPL_DAY5 1 GB 

BPL_DAY6 1 GB 

BPL_DAY7 1 GB 

PART_1 1 GB 

PART_2 1 GB 

PART_3 1 GB 

PART_4 1 GB 

MSG_PART_TBS1  1 GB 

LOB1 1 GB 

LOB2 1 GB 

LOB3 1 GB 

LOB4 1 GB 

LOB5 1 GB 

LOB6 1 GB 

LOB7 1 GB 

MSG_LOB_TBS1 1 GB 

TEMP 1 GB 

 

These tablespaces should be created first. A database administrator can write a script to create the 
tablespaces or use the provided procedure, which is described below. We recommend all OTM 

tablespaces are locally managed with automatic segment space management. 

The sizes specified above are minimal for the successful installation of the OTM database. LOB 
tablespaces are used to hold LOB objects, which are usually very space consuming. If the database is 
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being used immediately with integrations, we recommend double the size of these tablespaces at the 

creation time. We also recommend giving 20% - 50% more space to the other tablespaces. 

Using Provided Procedure to Create Tablespaces 

We provide a SQL script, create_gc3_tablespaces.sql, to create all tablespaces of the OTM database. 
This script can be run interactively, or by providing command line arguments. When you run this script 

interactively, you are prompted for options, which are explained below. All of the tablespaces are 
locally managed with uniform size set as 5MB for LOB tablespaces and 1MB for the others. Only one 
datafile is created for each tablespace. The datafiles of all tablespaces are created in the same 
directory that you specify. If you want to create dictionary-managed tablespaces, and/or create 
tablespaces in different file systems/directories, you should run the script with Execute Now option set 
to N. This way the process will generate create tablespaces statements in a log file. You can modify 
the statements and run them later manually. 

This script creates LOB tablespaces with 16 KB block size. This is the recommended block size for 
optimal performance. In order to create a tablespace with 16 KB block size, you should have the 
following init.ora parameter set if your database standard block size is not 16 KB. Change the cache 
size as needed for your database. 

db_16k_cache_size = 104857600 # 100MB for 16k block buffers 

To run the script, log in to the database as user SYS and run script:  

create_gc3_tablespaces.sql. 

Create Tablespace Options 

 Parameter Default Option (Y/N) 

This process sets the following parameters with default values. If you do not want to use these values, 
you should enter N. The default is Y. 

file size: 100MB 
maximum file size(if auto extend is on): 10GB  

 Parameter Value Option 

If you choose N for Parameter Default Option, you can enter values you want for the above 
parameters. Otherwise, just press Enter. 

 Autoextend Option 

 Enter N if you do not want your datafiles to be autoextended. Default is Y. 

 Datafile directory 

Enter full path of datafiles directory. The trailing slash (/) for UNIX/Linux or back-slash (\) should be 
included. 

 Executing-Now Option 

Enter Y if you want to let the process to create tablespaces for you. Otherwise the process will 
generate create statements in the log file. Default is N. 

Create Tablespaces, Non-interactive Mode 

The options described above define the calling arguments for the create_gc3_tablespaces.sql script. 

The script is run within the sqlplus environment. Run this script from the sqlplus command line by 
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providing suitable values for each of the parameters. The parameters are positional and listed again 

here: 

 Default Option Flag (Y/N)  

 Initial File Size  - Use appropriate suffix to define units (eg. 100M, 1G) 

 Maximum File Size – As above, use appropriate suffix (eg. 5G) 

 Autoextend Option – (Y/N) 

 Data file Directory 

 Execute-Now Option (Y/N) 

 

A sample Execution to avoid prompts: 

sql> @create_gc3_tablespaces.sql N 100M 10G Y "/u02/oradata/OTM" Y 

Create OTM Database Structure and Public Data 

These steps create application users, database users, database schema objects and load seed data.  

1. Set environment variable ORACLE_SID to your database SID. If the ORACLE_SID is not set 

within the system environment, you must set this within your current command prompt by 
typing “export ORACLE_SID=<your ORACLE_SID>”. You can check that this variable is active 

by typing “echo $ORACLE_SID”. You should see your ORACLE_SID displayed. 

2. Set environment variable NLS_LANG to: <LANGUAGE>_<TERRITORY>.<CHARCTERSET>. Here 

<LANGUAGE> is used for Oracle messages, sorting order, day names, and month names. 
<TERRITORY> specifies conventions for default dates, calendar, monetary, and numerical 

format. For example, if in USA, you can set the parameter to AMERICAN_AMERICA.AL32UTF8. 

Characterset AL32UTF8 is required for Oracle Transportation Management. For more 

information on NLS_LANG see the Oracle National Language Support Guide. 

3. Change to the <otm_install_path>/glog/oracle/script8 directory on the OTM application 

server.  

4. Create database users by running create_glog_users.sql script, which can be run interactively 

or non-interactively. This script creates following database users: 

 ARCHIVE_C 

 ARCHIVE_C_USER 

 GLOGDBA 

 GLOGOWNER 

 GLOGLOAD 

 REPORTOWNER 

 GLOBALREPORTUSER 

 DIR_XML_USER 

 GLOGOAQ 

Note: Passwords for GLOGDBA, GLOGLOAD, and ARCHIVE_C_USER must match the 

passwords entered while installing the application server in section “Installing OTM”. 

5. For interactive mode: In SQL*Plus, as user SYS run: 

@create_glog_users.sql 

The script will prompt for eleven arguments. The arguments, in order, are provided here: 

o Database Connection ID (must match tnsnames entry) 
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o DBA User – A database user account, other than SYS with privileges to create users 

(eg. SYSTEM) 

o DBA user password 

o SYS user password 

o ARCHIVE_C user password 

o GLOGDBA user password 

o GLOGOWNER user password 

o GLOGLOAD user password 

o REPORTOWNER user password 

o GLOBALREPORTUSER user password 

o DIR_XML_USER user password 

o ARCHIVE_C_USER user password 

o GLOGOAQ user password 

To Run in Non-interactive Mode 

Running in non-interactive mode is accomplished by adding the eleven arguments above as parameter 

values when executing the script. 

Note: Passwords for GLOGDBA, GLOGLOAD, and ARCHIVE_C_USER must match the 

passwords entered while installing application server in section “INSTALLING OTM”. 

A sample execution is shown below: 

@create_glog_users.sql OTMDB SYSTEM syspw systempw archivecpw glogdbapw 

glogownerpw glogloadpw reportownerpw globalreportuserpw dirxmluserpw 

archive_c_userpwd glogoaquserpw 

Create database schemas by running create_all script. This process is run at the host command 

line. Two command scripts are provided and the script you use is dependent on your operating 

system. 

Note: For 19c DB onwards follow the below steps. 

1. Before executing create_all script complete the following. 

a. Set to avoid errors updating users in the gl_user table during install. 

 alter system set sql92_security=false scope=spfile; 

 Or  

 Install bug# 25616268 

 

b. Change init parameter OPTIMIZER_DYNAMIC_SAMPLING to 11. 

alter system set OPTIMIZER_DYNAMIC_SAMPLING=11 scope=both sid='*'; 

2. After executing the create_all script. 

a. Change init parameter OPTIMIZER_DYNAMIC_SAMPLING back to 2. 

alter system set OPTIMIZER_DYNAMIC_SAMPLING=2 scope=both sid='*'; 

 

This will avoid the following error at the end of the create_all.sh script. 
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ORA-01652: unable to extend temp segment by 128 in tablespace TEMP 

 

UNIX shell script: 

 

./create_all.sh 

 
or 

 

Windows command line script: 

create_all.cmd  

3. Enter database connection ID, SYS user password, DBA user name (other than SYS user) 

which has privilege to create database users, DBA user password, property file directory 

location, and password for ARCHIVE_C, GLOGOWNER and REPORTOWNER, GLOGOAQ, 
ARCHIVE_C users. This step also create below listed application users, enter password for 

each of these users when prompted.  

Note: Passwords for “otmSystem” and “guest” users must match the passwords entered 

while installing application server in section “INSTALLING OTM” 

 otmSystem 

 guest 

 DBA.ADMIN 

 SERVPROV.ADMIN 

 GUEST.ADMIN 

 EBS.ADMIN 

 E1.ADMIN 

 FA.ADMIN 

  

To Run in Non-interactive Mode 

Running in non-interactive mode is accomplished by adding the sixteen arguments when executing the 

script in the order as specified below. 

./create_all.sh <Database TNS id> <SYSDBA password> 

<DBA user name (other than SYS user)who has privileges to create users (like 

SYSTEM)> 

<Password for DBA user> <Property file path> <GLOGOWNER password>       

<REPORTOWNER password> 

<Application user “otmSystem” password (password must match with “otmSystem” 

user password used during application installation)> 

<Application user “guest” password (password must match with “guest” user 

password used during application installation)> 

<Application user DBA.ADMIN password>  

<Application user SERVPROV.ADMIN password> 

<Application user GUEST.ADMIN password> 

<Application user EBS.ADMIN password> 

<Application user E1.ADMIN password> 

<Application user FA.ADMIN password> 

<Database user GLOGOAQ password> 

<Database user ARCHIVE_C password> 

Sample command: 

./create_all.sh otmdb syspwd system systempwd ../../config glogownerpwd 

reportownerpwd appotmSystempwd appguestpwd dbaadminpwd \ 
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 servprovadminpwd guestadminpwd ebsadminpwd e1adminpwd ebsadminpwd faadminpwd 

glogoaqpwd archive_c_pwd 

4. After the process has run, verify in the create_all_<dbsid>_<timestamp>.log file (located in 

the same directory as source) that there are no errors. Contact Technical Support if you find 

any errors like “ORA-“ or “Package Body created with compilation errors”. 

5. Also review the log files called import_content_<dbsid>_<timestamp>.log and 

update_password_<dbsid><timestamp>.log for errors (located in the same directory as the 

SQL script). Look for errors by searching key words like “ORA-“, “Caught exception”,”SP2-“, or 

“<Error>“ within the log file. Contact Technical Support if you find any errors. 

Note: This process loads java objects into the database. Ignore the following errors 

generated during load java process. 

errors   : source DbUTCDate 

 Note: DbUTCDate uses or overrides a deprecated API. 

 Note: Recompile with -Xlint:deprecation for details. 

 

errors   : source DbLocalTimestamp 

 Note: DbLocalTimestamp uses unchecked or unsafe operations. 

 Note: Recompile with -Xlint:unchecked for details. 

 

errors   : source PasswordEncrypter 

 Note: PasswordEncrypter uses unchecked or unsafe operations. 

 Note: Recompile with -Xlint:unchecked for details. 

 

errors   : source AutoCombine 

 Note: AutoCombine uses unchecked or unsafe operations. 

 Note: Recompile with -Xlint:unchecked for details. 

If Oracle Advanced Queue integration will be used to process inbound messages please refer to the 

Integration Guide for the required configuration details. These steps can be executed now or at any 
time later." 
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4. Installing Oracle Fusion Transportation Intelligence (FTI) 

OTM delivers the Oracle Fusion Transportation Intelligence (FTI) solution which includes the following 
components. For more details about these components and Oracle FTI, see the Oracle Fusion 

Transportation Intelligence Reference Guide. 

 Oracle Fusion Transportation Intelligence Extract Transform & Load (ETL): Pre-packaged ETL 

process deployed on an Oracle Data Integrator (ODI) instance 

 Oracle Fusion Transportation Intelligence Historical Database (HD): The analytics database for 

the Oracle Fusion Transportation Intelligence application 

 Oracle Fusion Transportation Intelligence Metadata: Delivered as advanced_analytics.rpd file 

 Oracle Fusion Transportation Intelligence Canned Reports: Delivered as aa_webcat.zip 

The steps required for installing and configuring Oracle FTI installation are detailed in this chapter. 

Note: Prerequisites for installing Oracle FTI are that you have experience with installing 

Oracle databases, OTM administration, OBI EE administration, ODI administration, and 

experience with Oracle ETL.  

Note: If you are installing Global Trade Intelligence or GTI, please see the next section, 

Installing Global Trade Intelligence (GTI). Although the installation of GTI is basically the 

same as FTI, there are some small differences. 

Installing Oracle FTI Historical Database (HD) 

Preparing OTM Database for FTI 

Operational Database 

Run the load_status_script.sql file. The script loads the READY_TO_LOAD status type with a status 

value of NOT_READY_TO_LOAD to all shipments, order bases, and order releases in OTM. This may 
take time depending on how many business objects are in the database. 

To run the script, complete the following: 

1. Log in to the OTM OLTP database as glogowner. 

2. In SQL*Plus, as user GLOGOWNER, run the following script: 

<otm_install_path>/glog/oracle/script8/advanced_analytics/load_status_script.sq

l 

Replicated Operational Database (ROD) Considerations 

The deployment architecture of Oracle FTI supports the following deployment choices for customers: 

1. Load Historical Database using ROD 
 

In this deployment, a ROD (that maintains a snapshot of the OTM OLTP database) is used. The 

Oracle FTI ETL jobs will connect to the ROD to load the Historical Database thereby de-

coupling the OTM OLTP database from the ETL process. 

2. Load Historical Database using OLTP (Online Transaction Processing Database). 

 

In this deployment, the Oracle FTI ETL jobs will connect directly to the OTM OLTP database to 
load the Historical Database adding to additional database workload on the OTM OLTP 

database. 
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It is strongly recommended that you use a ROD to achieve performance gains and to efficiently 

balance the load on the OTM OLTP database. 

Historical Database (HD) Considerations 

The Historical Database (HD) schema can be created on a separate database beginning with OTM 6.2. 
This schema can also share the ROD or the OLTP database. 

Creating Historical Database (HD), Users, and Packages 

The create_aa_all.sql calls the CSV load utility. This utility obtains the details of an Oracle FTI 

database from the property files and property sets. Before invoking the SQL script,  

1. Set the following properties in the CUSTOM property set: 

Table 4-1 

Key Value Description 

glog.database.fti.password  Oracle FTI database password 

 

2. Also set the following properties in the glog.properties file: 

Table 4-2 

Key Value Description 

glog.database.fti.dbserver ftihost.mycompany.co

m 

Fully qualified domain name of 

the Oracle FTI database 

glog.database.fti.port 1521 Port that Oracle is using on the 
Oracle FTI database server 

glog.database.fti.sid  Oracle FTI database service 
name 

 

See the Custom Properties section of the Administration Guide for more information. 

Creating FTI Tablespaces 

FTI requires two tablespaces: DATA and INDX. You should execute the create_aa_tablespaces.sql 

script to create the tablespaces required for the HD. 

1. On the database (as per your deployment architecture discussed above) where you want to 

install Oracle FTI, log into SQL*Plus as user SYS and run the following script from 

advanced_analytics directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_tablespa

ces.sql 

2. The script asks a series of questions: 

a. Review the default parameters listed and select Y to use the default or N to change 

them. 
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b. Enter the file size. 

 

You can use K or M. Press ENTER to use the FTI default. 

c. Please enter maximum file size. 

 

It must greater than (file_size + 250M). Press ENTER if you use FTI/GTI default. 

d. Enter Y or N to set auto extend on for data files. 

 

The default is Y. 

e. Enter the directory where you want the data files to be located including trailing 

"/" or "\". 

f. Enter Y or N to create tablespaces now. 

 

The default is N. 

Creating FTI Database Users 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle FTI. 

FTI database users can be created either interactively or non-interactively by running 

create_aa_users.sql script. This script creates following users. 

 HDOWNER 

 FTIODIMASTER 

 FTIODIWORK 

 FTIODISTAGE 

 

To create FTI Database Users Interactively: 

1. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_users.sq

l 

Note: Password for HDOWNER must match the password entered while installing 

application server in section “INSTALLING OTM”. 

The script will prompt for eight arguments. The arguments, in order are provided here: 

 FTI Database Connection ID (must match tnsnames entry): <db_sid> 

 

 DBA User: A database user account, other than SYS with privileges to create users (eg. 

SYSTEM) 

 DBA user password 

 SYS user password 

 HDOWNER user password 

 FTIODIMASTER user password 

 FTIODIWORK user password 

 FTIODISTAGE user password 

  
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To create FTI Database Users Non interactively: 

Note: Password for HDOWNER must match the password entered while installing 

application server in section “INSTALLING OTM”.  

Make note of the new passwords you enter for the Oracle Database Intelligence database 
users FTIODIMASTER, FTIODIWORK and FTIODISTAGE. You will need these in the ODI 

deployment steps for FTI in the subsequent sections. 

1. As above, run the create_aa_users.sql script and provide the arguments defined. 

A sample execution is: 

@create_aa_users.sql  FTIDB SYSTEM systempwd syspw hdownerpw ftiodimasterpw 

ftiodiworkpw ftiodistagepw 

Creating FTI Database Structure and Public Data 

1. Log into the database (as per your deployment architecture discussed above) where you want 

to install Oracle FTI. 

2. Using SQL*Plus, as user SYS, run the following script from the directory: 

<otm_install_path>\glog\oracle\script8\advanced_analytics\create_aa_all.sql 

a. Enter your Connection ID to the Oracle FTI Historical Database (HD) when prompted. 

 

This is specified in the glog.database.fti.sid property. 

b. Enter the password for the HDOWNER user of your FTI database. 
This is the HDOWNER user password of your FTI database. See the 

glog.database.fti.password property. 

c. Enter the SYS user password for the FTI database to login as SYSDBA. 

d. Enter connection string to the OLTP database when prompted. 

 

The OLTP database is your OTM database. 

e. Enter the GLOGOWNER user password of your OLTP database. 

 

The OLTP database is your OTM database. 

f. Enter Y or N depending on machine type (UNIX or Windows). 

g. Enter path of directory where glog.properties file is located. 

3. After the process has run, there should be four log files generated. 

a. create_aa_all.log 

b. csvone_aa_W_LOCALIZED_STRING_G.log  

c. user_sdo_cached_maps.log 

d. imp_w_province_g.log 

4. Contact Technical Support if you find any errors like “ORA-“ or “Package Body created with 
compilation errors”. Also verify that the csvone_aa_W_LOCALIZED_STRING_G.log file does not 

have any errors like “ORA-“, “Caught exception”,”SP2-“, or “<Error>”. 

 
The user_sdo_cached_maps.log file should show that one row was successfully loaded and 

zero rows had errors. If the process creates the file user_sdo_cached_maps.bad then there 

may be error during data upload. The imp_w_province_g.log file should not have any errors 

like “ORA-“ or “IMP-“. Contact Technical Support if you find any other errors. 

1. . 
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Installing Oracle Data Integrator (ODI) 

Certain files required for Oracle Data Integrator installations are available under 

<otm_install_path>/fti. If Oracle Data Integrator is installed on a different server than OTM, please 

copy these files to a folder where the installing user has write permissions. 

Note: The minimum settings required for installing Oracle Data Integrator for Oracle FTI 

are listed below. Refer to the Oracle Data Integrator Installation Manual for detailed 

instructions on how to install Oracle Data Integrator. 

Note: Installing the ODI agent in the database tier provides better performance than 

installing it in the application tier. 

Prerequisites: JDK version 1.8 installed. Refer to 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-

configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1 for installing 

JDK. 

Install Oracle Fusion Middleware Infrastructure 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/infin/index.html for installing 

Oracle Fusion Middle Infrastructure. 

1. Launch the installation program by invoking the java -jar from the JDK directory on your 

system as shown in the examples below: 

 On UNIX operating systems:  

 
/home/Oracle/Java/jdk1.8.0_211/bin/java -jar 

fmw_12.2.1.4.0_infrastructure.jar 

 On Windows operating systems:  

 
C:\Program Files\Java\jdk 1.8.0_211\bin\java -jar 

fmw_12.2.1.4.0_infrastructure.jar 

Note: Be sure to replace JDK file location in these examples with the actual JDK location on 

your system. 

2. On the Welcome screen of the Oracle Fusion Middleware Infrastructure installation wizard, 

click Next >. 

3. On the Installation Location screen, specify the location of your Oracle home directory. 

4. Click Next >. 

5. On the Installation Type screen, select Fusion Middleware Infrastructure. 

6. Click Next >. 

7. On the Prerequisite Checks: verify that your system meets the minimum necessary 

requirements.  
 

If you get warning or error message, please following instructions in message. 

8. Click Next >. 

9. On Installation Summary screen, verify the installation options you selected.  

10. Click Install >. 

11. You see an Installation Progress screen which allows you to see the progress of the 

installation. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/infin/index.html
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12. On the Installation Complete screen, review the information on this screen and click Finish to 

complete the installation. 

Installing Oracle Data Integrator 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-
software.html for installing Oracle Data Integrator.  

1. Launch the installation program by invoking the  java –jar from the JDK directory on your 

system, as shown in the examples below: 

o On UNIX operating systems: 

 

/home/Oracle/Java/jdk1.8.0_211/bin/java -jar fmw_12.2.1.4.0_odi.jar 

o On Windows operating systems: 
 

C:\Program Files\Java\jdk 1.8.0_211\bin\java -jar fmw_12.2.1.4.0_odi.jar  

Note: Be sure to replace JDK location in these examples with the actual JDK location on 

your system. 

2. On the Welcome screen installation wizard, click Next >. 

3. On the Installation Location screen, specify the location of your Oracle home directory.  

Note: Specify same oracle home location as middleware infrastructure oracle home. 

4. On the Installation Type screen, select installation type of Enterprise Installation. 

5. Click Next >. 

6. On the Prerequisite Checks screen verify that your system meets the minimum 

necessary requirements. 

Note: If there are any warnings or error messages, refer to the ODI installation 

documentation referenced above. 

7. Click Next >. 

8. On the Specify Security Updates screen, choose how you want to be notified about security 

issues: 

a. If you want to be notified about security issues through email, enter your email 

address in the Email field. 

b. If you want to be notified about security issues through My Oracle Support, select the 

My Oracle Support option. Enter your email address in the Email field and enter your 

My Oracle Support Password. 

c. If you do not want to be notified about security issues, clear the check box and leave 
all fields empty. 

 

You will see the following message: "My Oracle Support Username/E-mail address not 

specified". 

d. Click Yes to continue. 

9. Click Next >. 

10. On the Installation Summary screen, verify the installation options you selected.  

11. Click Install >. 

12. Use the Installation Progress screen to view the progress of the installation. 

 

The Installation Complete screen appears when the installation is complete. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-software.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-software.html
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13. Review the information on the Installation Complete screen, and click Finish to dismiss the 

installer. 

 

Configuring ODI for Oracle FTI ETL 

Creating a New Oracle Data Integrator Repository Login 

Next, you create a login to connect to the Oracle Data Integrator repository. 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/odi/stuido/odi.exe or 

c. In Linux, run <ODI_HOME>/odi/studio/odi.sh 

Note: As soon as you open ODI Studio for the first time, you are prompted for the JDK 

Home which needs to be set. 

2. Open the New Gallery by choosing File > New. 

3. In the New Gallery window, in the Categories tree, select ODI.  

4. From the Items list, select Create a New ODI Repository Login. 

5. Click OK.  

 

The Repository Connection Information Screen opens. 

6. In the Oracle Data Integrator Connection section enter the following: 

a. Login name: A generic alias (for example: DEVREP) 

b. User: SUPERVISOR (use capitals) 

c. Password: Refer to the ODI Installation Guide for the ODI SUPERVISOR user 

password and enter that here. (Default value is SUNOPSIS.) 

7. In the Database Connection (Master Repository) section enter the following: 

a. User: ftiodimaster 

b. Password: Enter the password for ftiodimaster user. 

 

(This is the password for the ftiodimaster user that you entered when you ran the 

create_odi_users.sql script.) 

c. Drivers List: Choose Oracle JDBC Driver 

d. URL (standard server configuration only): Enter the complete JDBC URL for the 

master repository data server. 

 
For example: jdbc:oracle:thin:@<FTI DB SERVER NAME>:<FTI DB PORT>:<FTI DB 

SID> 

 
See the following properties for these settings: glog.database.fti.dbserver, 

glog.database.fti.port and glog.database.fti.sid. 

e. URL (RAC configuration only): Enter the RAC SCAN listener address and the service 

name as part of the URL as follows: 
 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

Note: Don’t click on Test Connection button to test the connection; because the master 

repository is not yet created. 
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8. In the Work Repository section, enter the following: 

a. Select the Master Repository Only option. 

b. Click OK. 

c. Select Yes to make this the default login. 

d. Click OK again. 

9. You get an alert regarding the Security wallet, asking whether you want to store the 
passwords.  

 

Select the option Store passwords without secure wallet. 

 

Creating the Master Repository and Importing the Artifacts Next, you create the tables and 
automatically import the definitions for the new ODI master repository. Due to performance, it is 

recommended that you have separate FTI ODI repositories instead of incorporating them along with 

other ODI applications. 

 The user completing this procedure must have write access to the folder that contains the 

FTI_ETL_TOPOLOGY.zip, FTI_ETL_SECURITY.zip, and FTI_ETL_WORK.zip files. 

 These files are available under <otm_install_path>/fti 

 If Oracle Data Integrator is installed on a different server, please copy these files to a folder 

where the installing user has write permissions. 

To create the master repository and import the artifacts, complete the following: 

10. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/odi/studio/odi.exe, or 

c. In Linux, run <ODI_HOME>/odi/studio/odi.sh 

11. Select File > New to open a new gallery. 

12. In the New Gallery window, in the Categories tree, select ODI. 

13. From the Items list, select Create a New Master Repository. 

14. Click OK. 

15. In the Database Connection section, complete the following: 

a. Technology: From the list, choose Oracle. 

b. JDBC Driver: Keep the default oracle.jdbc.OracleDriver 

c. JDBC URL: Enter the analytics databse URL. 

d. User: enter ftiodimaster 

e. Password: enter ftiodimaster password 

Note: You must connect as SYSDBA so enter “sys as SYSDBA”. 

f. DBA User:<System User> 

g. DBA Password: <System User Password> 

h. Click Next. 

i. Enter SUPERVISOR password and confirm the password. 

j. Click Finish. 

16. Click Finish to begin master repository creation. 

 

This process may take up to 10 minutes. 
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17. Select the Topology tab. 

18. Click Connect to Repository. 

19. Enter the following: 

a. Login Name: Choose the login name you created. 

b. User: Enter SUPERVISOR 

c. Password: Enter SUPERVISOR’s password. 

d. Click OK. 

20. On the Topology tab, select Import > Import Topology. 

21. Click OK. 

22. Select an Import Mode of Synonym Mode Insert Update. 

23. Select Import from Zip file. 

24. Browse to and select FTI_ETL_TOPOLOGY.zip and click OK. 

25. On the Security tab, select Import > Import Security Settings.  

26. Click OK. 

27. Select an Import Mode of Synonym Mode Insert Update. 

28. Select Import from Zip file. 

29. Browse to and select FTI_ETL_SECURITY.zip and click OK. 

30. Validate the JDBC URLs for source and target databases by completing the following for each 

schema listed below: 

o ORACLE_FTI: (QA or PROD or UAT) Environment’s historical database hdowner 

schema mapped to global context. Enter the JDBC URL of the FTI production/QA/UAT 

database which contains the HDOWNER schema.  
 

See the following properties for these settings: glog.database.fti.dbserver, 

glog.database.fti.port and glog.database.fti.sid. 

o ORACLE_FTI_DEV: Development environment’s historical database hdowner schema 
mapped to development context.  

 

Note: If you do not have a development environment, you do not need to specify this 

URL. 

o ORACLE_OTM: (QA or PROD or UAT) Environment’s OTM glogowner schema mapped 

to global context. 

 

This is the JDBC URL for your OTM server. 

o ORACLE_OTM_DEV: Development environment’s OTM glogowner schema mapped to 

development context.  

 
Note: If you do not have a development environment, you do not need to specify this 

URL. If the target database is a RAC, make sure to use the SCAN listener and service 

name in the URL. 

31. To validate the URLs, complete the following for each schema listed above: 

a. Click on the Connect To Repository… link. 

b. In the Login Name list, choose the ODI repository login. 

c. Click OK. 

d. Click on Topology tab. 

e. Go to the Physical Architecture pane and expand Technologies > Oracle. 

f. Double-click the schema name (for example, ORACLE_FTI). 

g. Click the JDBC tab. 
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h. Enter the corresponding JDBC URL for each schema. 

 

The JDBC URL should be in the form of jdbc:oracle:thin:@<DB SERVER>:<DB 

PORT>:<DB SID>. See the explanations in step 9 above to determine what URL to use 

for each schema. 

32. Next, for each schema listed above make sure connection to the data server is set up correctly 

as follows: 

a. Click Definition tab. 

b. In the Connection section, for the ORACLE_FTI and ORACLE_FTI_DEV schemas, 

enter the following: 

i. User: ftiodistage. 

ii. Password: <password for the ftiodistage user>. 
 

This is the password for the ftiodistage user that you entered when you ran 

the create_odi_users.sql script. 

c. In the Connection section for the ORACLE_OTM and ORACLE_OTM_DEV schemas, 

enter the following: 

i. User: glogdba 

ii. Password: <password for the glogdba user> 

 

Refer to your OTM administrator for this information. 

33. Click the Save All button. 

34. Expand Agents and double-click the OracleDIAgent agent. 

35. In the Host field, give the server name or the IP address of the machine where you 

installed ODI. 

36. Click the Save All button. 

 

Troubleshooting 

If you see a development context error when importing FTI_ETL_TOPOLOGY.zip, try completing the 

following: 

1. Go to Topology > Physical Architecture > Contexts. 

2. Rename the Development context to Development1  

3. Try the import again. 

 

Creating the Work Repository 

To create a work repository, complete the following: 

1. In the Topology Navigator, go to the Repositories panel. 

2. Right-click the Work Repositories node and select New Work Repository. 

3. In the Create Work Repository wizard, specify the Oracle Data Integrator work repository 

connection details as follows:  

a. Technology: Choose Oracle.  

 

The default is Oracle. 

b. JDBC Driver: oracle.jdbc.OracleDriver 
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c. JDBC URL (standard server configuration only): The complete path of the data 

server to host the work repository.  

 

For example: jdbc:oracle:thin:@<FTI DB SERVER>:<FTI DB PORT>:<FTI DB SID> 

d. JDBC URL (RAC configuration only): Enter the RAC SCAN listener address and the 
service name as part of the URL as follows: 

 

For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 

e. User: ftiodiwork 

f. Password: Enter the password for ftiodiwork user. 

 

(This is the password for the ftiodiwork user that you entered when you ran the 

create_odi_users.sql script. 

4. Click Test Connection to check the connection is working. 

5. Click Next >. 

6. Specify the Oracle Data Integrator work repository details:  

a. Name: Give a unique name to your work repository (for example: FTI_WORK). Try to 

have only letters or numbers. Don’t use special characters and spaces in between the 

words.  

b. Password: leave blank 

c. Work Repository Type: Choose Development from the list. 

Note: It is recommended that you select a Work Repository Type of Development since 
this type allows you to make changes to the work repository in the future. If you select 

a work repository type of Production, then you will not be able to edit the work 

repository. 

7. Click Finish. 

 

The Create Login dialog box opens. 

8. Click No. 

9. Click Save in the toolbar. 

Importing the Work Repository 

To import the work repository, complete the following: 

1. If you connected to the master repository only, disconnect by clicking: ODI > Disconnect 

<Login name >. 

2. On the Designer tab, click Connect to Repository… 

3. On the Oracle Data Integrator Login screen, click the pencil icon to edit the Login Name. 

4. On the Repository Connection Information screen in the Work Repository section, select the 

Work Repository option. 

5. Search for and select the name that you entered in the previous section, Creating the Work 

Repository. 

6. Click OK on the Repository Connection Information screen. 

7. Click OK on the Oracle Data Integrator Login screen. 

8. Connect to the work repository. 

9. From Designer tab, click the Connect Navigator icon, then select Import > Import the 

Work Repository. 

10. Click OK. 
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11. Specify an Import Mode of Synonym Mode INSERT_UPDATE. 

12. Select the Import From a Zip File check box. 

13. Choose FTI_ETL_WORK.zip.  
 

This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on the ODI 

server. 

14. Click OK to import the work repository. 

 

This process may take up to 40 minutes. Do not close or kill the process. 

Note: During this process you may get a dialog box saying that the ID <object ID> does 

not exist. Click OK to create it. 

Troubleshooting 

If you see an error importing the Work Repository FTI_ETL_WORK.zip file, try completing the 
following: 

1. Make a backup of the FTI_ETL_WORK.zip file. 

2. Extract the FTI_ETL_WORK.zip file. 

3. In the FTI_ETL_WORK folder, the MAP_Copy_of_INCR_W_GTM_ITEM_F.xml file. 

4. Now, in the FTI_ETL_WORK folder, select all the XML files, zip them up as FTI_ETL_WORK.zip.  

Note: Zip the XML files only, and not the FTI_ETL_WORK folder. 

5. Import this newly created FTI_ETL_WORK.zip into ODI. 

 

Starting the Oracle Data Integrator J2EE Agent  

Creating J2EE Agent Repositories 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-
repository-schemas.html to create schemas. Note that you already created the ODI master and ODI 

work schemas and only need following additional schemas. 

 Audit Services(<PREFIX>_IAU) 

 Audit Services Append(<PREFIX>_IAU_APPEND) 

 Audit Services Viewer (<PREFIX>_IAU_VIEWER) 

 Oracle Platform Security Services(<PREFIX>_OPSS) 

 Service Table(<PREFIX_STB>) 

Starting the RCU 

1. Go to the ORACLE_HOME/oracle_common/bin directory and start the Repository Creation Utility 

(RCU) as follows: 

a. Set the JAVA_HOME environment variable to your JDK location. 

i. On UNIX operating systems: setenv JAVA_HOME 

/home/Oracle/Java/<JDK_17_HOME> 

ii. On Windows operating systems: 

1. Right-click on My Computer. 

2. Select Properties. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-repository-schemas.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-repository-schemas.html
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3. Click Advanced System Settings in the left column. 

4. Click Environment Variables in the System Properties window. 

5. In the Environment Variables window, set the system variable 

JAVA_HOME to your JDK location and click OK. 

6. On the Environmental Variables window, click OK. 

7. On the System Properties window, click OK. 

b. Start RCU as follow:  

i. Open a command prompt and enter the following: 

1. cd <ODI_Home>\oracle_common\bin 

2. On UNIX operating systems: ./rcu 

3. On Windows operating systems: rcu.bat 

Navigating the RCU Screens to Create the Schema 

1. On the Introducing RCU screen, click Next>. 

2. On the Create Repository screen, select System Load and Product Load Concurrently. 

3. Click Next. 

4. On the Providing Database Connection Details screen, provide the database connection 

details for RCU to connect to your database.  

5. Click Next. 

6. Click OK on the dialog window confirming that connection to the database was successful. 

7. On the Select Components screen, select Create a new prefix. 

a. Specify a new prefix. 

Note: You must make a note of the new prefix you choose to enter here; you will 

need this later on during the domain creation process. 

b. Select the Oracle Data Integrator schema. This will also select the required 

supporting Common Schemas.  
 

The prefix is used to logically group these schemas together for use in this domain 

only; you must create a unique set of schemas for each domain as schema sharing 

across domains is not supported. 

c. Deselect Master and Work Repository as you do not need them.  

Note: These were created so do not create them again! 

d. Deselect the Oracle Data Integrator schema before continuing. This will ensure 

that only the Master and Work Repository option is deselected, while the Common 

Schemas still remain selected. 

e. Click Next. 

f. Click OK on the window confirming that prerequisite checking for schema creation was 

successful. 

8. On the Specifying Schema Passwords screen, specify how you want to set the schema 

passwords on your database. 

9. Specify and confirm your passwords. 

10. On the Setting Custom Variables screen, you do not need to specify any custom variables. Just 

click Next > to continue the schema creation. 

11. Navigate through the remainder of the RCU screens to complete schema creation. 

12. In the completion screen, click Create. 

13. When you reach the Completion Summary screen, click Close to dismiss the RCU. 
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Configuring the WebLogic Domain for the Java EE Agent 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-
agent.html to configure weblogic domain for the Java EE Agent. 

This section provides instructions for creating a WebLogic domain for your Java EE agent using the 
configuration wizard. The following topics are covered in this section: 

Starting the Configuration Wizard 

1. To begin domain configuration, navigate to the ORACLE_HOME/oracle_common/common/bin 

directory and start the WebLogic Server Configuration Wizard. 

a. On UNIX operating systems:  

./config.sh 

b. On Microsoft Windows operating systems:  

config.cmd 

Navigating the Configuration Wizard Screens to Configure the Domain 

1. Selecting the Domain Type and Domain Home Location: 

a. On the Configuration Type screen, select Create a New Domain.  

b. In the Domain Location field, specify your Domain home directory. 

c. Click Next. 

2. Selecting the Configuration Templates: 

a. On the Templates screen, make sure Create Domain Using Product Templates is 

selected. 

b. Select the following templates: 

 Oracle Enterprise Manager Plugin for ODI - 12.2.1.4.0[em] 

 Oracle Data Integrator - Agent - 12.2.1.4.0[odi] 

 Oracle Data Integrator - Console - 12.2.1.4.0[odi] 

 Oracle Integrator – JRF Async web services 

 Oracle data Integrator – REST service 

Note: Above selection will automatically select dependent jars. 

c. Click Next. 

3. Selecting the Application Home Location: 

a. On the Application Location screen, select the location where you want to store 

your applications associated with your domain. This location is also referred to as 

the Application home directory. 

b. Click Next. 

4. Configuring the Administrator Account: 

a. On the Administrator Account screen, specify the user name and password for the 

default WebLogic Administrator account for the domain. 

b. Click Next. 

Note: It is recommended that you make a note of the user name and password specified 

on this screen; you will need these credentials later to boot and connect to the domain's 

Administration Server. 

5. Specifying the Domain Mode and JDK: 

a. Select Production or Development as needed, in the Domain Mode field. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-agent.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-agent.html
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b. Select the Oracle HotSpot JDK in the JDK field. 

c. Click Next. 

6. Specifying the Datasource Configuration Type: 

a. Select RCU Data to activate the fields on this screen.  
 

The RCU Data option instructs the Configuration Wizard to connect to the database 

and Service Table (STB) schema to automatically retrieve schema information for the 

schemas needed to configure the domain.  

b. Click Get RCU Configuration when you are finished specifying the database 

connection information. 

Note: Choose Manual Configuration on this screen, you will have to manually fill in 

the parameters for your schema on the JDBC Component Schema screen. 

Note: For master and work repositories you must use ftiodimaster/ftiodiwork as 

these were created previously by the install script. The rest of the schemas are 

created in Create J2EE Agent Repositories section by the RCU. 

c. Click Next. 

7. Specifying JDBC Component Schema Information: 

a. Verify that the values on the JDBC Component Schema screen are correct for all 

schemas. If you selected RCU Data on the previous screen, the schema table should 

already be populated appropriately. 

b. Click Next. 

8. Testing the JDBC Connections: 

a. Use the JDBC Component Schema Test screen to test the datasource connections you 
have just configured. 

 

A green check mark in the Status column indicates a successful test. If you encounter 
any issues, see the error message in the Connection Result Log section of the screen, 

fix the problem, then try to test the connection again. 

b. Click Next. 

9. Specifying Supervisor Credentials: 

 

Use the Credentials screen to create the following two keys: 

a. A key for the Supervisor user already exists. Modify the credential as follows: 

i. Specify SUPERVISOR (all CAPS) as the user name. This is the default name 

initially assigned to the Supervisor account and cannot be changed unless you 

create a new Supervisor account. 

ii. The password must be the same password specified on the Custom Variables 

screen in RCU during schema creation. 

b. Create a second credential (only if needed for your implementation) as follows: 

i. Click the Plus sign (+) icon to add a new credential. 

ii. In the Key Name field, enter the name of this domain as the key. 

iii. In the Username and Password fields, provide the Administrator user's user 

name and password. 

iv. Select oracle.odi.credmap as the store name. 

c. Click Next. 

10. Selecting Advanced Configuration: 

a. To complete domain configuration for the topology, select the following options on the 

Advanced Configuration screen: 

https://docs.oracle.com/middleware/1213/wls/WLDCW/configuration_screens.htm#WLDCW211
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 Administration Server 

This is required to properly configure the listen address of the Administration 

Server. 

 Node Manager 

This is required to configure Node Manager. 

 Topology 

This is required to configure the Oracle Data Integrator Managed Server. 

b. Click Next. 

11. Configuring the Administration Server Listen Address: 

a. On the Administration Server screen, select the drop-down list next to Listen Address 

and select the IP address on the host where the Administration Server will reside.  

b. Do not use "All Local Addresses." 

c. Do not specify any server groups for the Administration Server. 

d. Click Next. 

12. Configuring Node Manager: 

 
The Node Manager screen can be used to select the type of Node Manager you want to 

configure, along with the Node Manager credentials. 

a. Select Per Domain as the Node Manager type. 

b. Specify the Node Manager credentials. 

c. Click Next. 

13. Configuring Managed Servers: 

 

On the Managed Servers screen, a new Managed Server named ODI_server1 is created: 

a. In the Listen Address drop-down list, select the IP address of the host on which 

the Managed Server will reside. 

b. Do not use "All Local Addresses". 

c. In the Server Groups drop-down list, select JRF-MAN-SVR; if there are other Groups 

selected, leave them as is. This server group ensures that the Oracle JRF services are 

targeted to the Managed Servers you are creating. 

d. If needed, change the name of the managed server, but note down the name of the 

managed server as it will be needed while starting the servers for the agent. 

 
Server groups target Fusion Middleware applications and services to one or more 

servers by mapping defined application service groups to each defined server group. A 

given application service group may be mapped to multiple server groups if needed. 
Any application services that are mapped to a given server group are automatically 

targeted to all servers that are assigned to that group. 

 
These server names and will be referenced throughout this document; if you choose 

different names be sure to replace them as needed. 

e. Click Next. 

14. Configuring a Cluster: 

 

Use the Clusters screen to create a new cluster: 

a. Click the Add button. 

b. Specify ODI_cluster1in the Cluster Name field. 
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c. Leave the Cluster Address field blank. 

 

By default, server instances in a cluster communicate with one another using unicast. 

If you want to change your cluster communications to use multicast, refer to 

"Communications In a Cluster" in Administering Clusters for Oracle WebLogic Server. 

d. Click Next. 

15. Configuring Server Templates: 

a. No change is needed on this screen.  

b. Click Next. 

16. Configuring Dynamic servers: 

a. No change is needed on this screen. 

b. Click Next. 

17. Assigning the Managed Server to the Cluster 

 

Use the Assign Servers to Clusters screen to assign ODI_server1 to the new cluster 

ODI_cluster1: 

a. In the Clusters pane, select the cluster to which you want to assign the servers; in this 

case, ODI_cluster1. 

b. In the Servers pane, assign ODI_server1 to ODI_cluster1 by doing one of the 

following: 

i. Click once on ODI_server1 to select it. 

ii. Then click on the right arrow to move it beneath the selected cluster 

(ODI_cluster1) in the Clusters pane. 

iii. Double-click on ODI_server1 to move it beneath the selected cluster 

(ODI_cluster1) in the clusters pane. 

c. Click Next. 

18. Configuring Coherence Clusters: 

a. Use the Coherence Clusters screen to configure the Coherence cluster that is 

automatically added to the domain. 

b. Leave the default port number as the Coherence cluster listen port. 

c. Click Next. 

19. Creating a New Machine: 
 

Use the Machines screen to create a new machine in the domain. A machine is required in 

order for the Node Manager to be able to start and stop the servers. 

a. Click the Add button to create a new machine. 

b. Specify ODI_machine1 in the Name field. 

c. In the Node Manager Listen Address field, select the IP address of the machine 

where the Managed Servers are being configured. 

 

You must select a specific interface and not "localhost." This allows Coherence cluster 

addresses to be dynamically calculated. 

d. Verify the port in the Node Manager Listen Port field. 

e. Click Next. 

20. Assigning Servers to Machines:  

 

Use the Assign Servers to Machines screen to assign the Administration Server and Managed 

Server to the new machine you just created: 

https://docs.oracle.com/en/middleware/fusion-middleware/weblogic-server/12.2.1.4/clust/features.html#GUID-A0F3CCDD-B502-47E7-B72A-
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a. In the Machines pane, select the machine to which you want to assign the servers; in 

this case, ODI_machine1. 

b. In the Servers pane, assign AdminServer to ODI_machine1 by doing one of the 

following: 

i. Click once on AdminServer to select it. 

ii. Then click on the right arrow to move it beneath the selected machine 

(ODI_machine1) in the Machines pane. 

iii. Double-click on AdminServer to move it beneath the selected machine 

(ODI_machine1) in the Machines pane. 

c. Repeat to assign ODI_server1 to ODI_machine1. 

d. Click Next. 

21. Configuring Virtual Targets: 

a. No change is needed on this screen. 

b. Click Next. 

22. Configuring Partitions: 

a. No change is needed on this screen. 

b. Click Next. 

23. Reviewing Your Configuration Specifications and Configuring the Domain: 

 

The Configuration Summary screen contains the detailed configuration information for the 
domain you are about to create. Review the details of each item on the screen and verify that 

the information is correct. 

a. You can go back to any previous screen if you need to make any changes, either by 

using the Back button or by selecting the screen in the navigation pane. 

b. Domain creation will not begin until you click Create. 

24. Writing Down Your Domain Home and Administration Server URL: 
 

The Configuration Success screen will show the Domain home location and URL of the 

Administration Server you just configured. 

a. You must make a note of both items as you will need them to start the servers in your 

domain. 

b. Click Finish to dismiss the configuration wizard. 

Note for Windows: 

 Set the environment variable MW_HOME for middleware home, if not set.  

 

For example, MW_HOME=C:\ODI\ODI_Home. 

Note for Linux: 

Set the MW_HOME variable to the appropriate path depending on shell. 

setenv MW_HOME  /opt/ODI/ODI_Home (csh) 

export MW_HOME=/opt/ODI/ODI_HOME(bash) 

MW_HOME value should be set for all future sessions. 

echo ’setenv MW_HOME  /opt/ODI/ODI_Home (csh) ' >>~/.tcshrc(for csh) 

Please note that this command will be different for different shells. 
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Creating a Java EE Agent in the Master Repository Using ODI Studio 

Starting the Oracle Data Integrator Agent 

To start the Oracle Data Integrator agent, complete the following: 

1. In ODI Studio, go to the Topology Tab > Physical Architecture. 

2. Expand Agents. 

3. Double click on OracleDIAgent. 

4. Enter Host and Port save it.  

Note: Host is machine name/IP Address of machine where you installed ODI Weblogic. 

Note: If ODI is installed with OBIEE or OTM in the same server, then run the following 

command before starting the ODI services: 

unset CLASSPATH 

Starting the Node Manager 

1. Go to the <ODI_HOME>/user_projects/domains/<odi_domain>/bin directory. 

2. On UNIX operating systems, start the Node Manager as shown below, using nohup and nm.out 

as an example output file: 

nohup ./startNodeManager.sh > nm.out & 

3. On Windows operating systems, run: 

startNodeManager.cmd 

Starting the Administration Server 

1. To start the Administration Server, go to the DOMAIN_HOME/bin directory. 

2. On UNIX operating systems, start the Node Manager as shown below, using nohup as an 

example output file: 

nohup ./startWebLogic.sh >CONSOLELOG.OUT & 

3. On Windows operating systems, run: 

startWebLogic.cmd 

Starting the Managed Server 

1. To start the Managed Server, go to the DOMAIN_HOME/bin directory. 

2. On UNIX operating systems, start the Node Manager as shown below, using nohup and as an 

example output file: 

nohup ./startManagedWebLogic.sh <ODI_server1> <weblogichost>:<port> 

>MANAGEDSERVERLOG.OUT & 

3. On Windows operating systems, run: 

startManagedWebLogic.cmd <ODI_server1> <weblogichost>:<port> 
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Installing Oracle Business Intelligence Enterprise Edition (OBIEE) 

For detailed installation steps of OBIEE on your preferred operating system, please refer to the 
corresponding OBIEE installation documentation. 

Oracle FTI is officially certified only for OBIEE deployed using WebLogic. If you need to use a web 

application server of your choice, then please refer the OBIEE documentation for the compatibility of 
OBIEE on your choice of web application server and also for detailed deployment instructions. 

Installing OTM and FTI on Single Server 

OTM and Oracle FTI can be installed on the same server by following these guidelines. Skip this 
section if you choose to have OTM and FTI on different machines. 

The server machine must be a multi-homed system (two hostnames/IP addresses) which means a 

single server with two network cards. 

 Primary hostname: should contain the OBIEE install 

 Secondary hostname: should contain the OTM install 

Guidelines for Installing OTM and FTI on Single Server 

1. OTM should be brought down to unblock the default WebLogic Admin port (9500). 

Install OBIEE per the OBIEE installation instructions. 

Note: By default OBIEE uses the primary hostname and default port (9500) for installation. 

2. Stop OBIEE per the OBIEE installation instructions. 

3. Restart the server. 

4. Start OTM. 

5. Restart OBIEE per the OBIEE installation instructions. 

 

Creating Repository Schema Using the Repository Creation Utility 

For OBIEE 12c, schemas are created during the configuration step using Configuration Assistant. 

Refer to Fusion Middleware Creating Schemas with the Repository Creation Utility document for more 

details. 

Installing OBIEE 

The version of OBIEE recommended for 6.4.3 FTI is OBIEE 12.2.1.4.0. 

Installing OBIEE 12c involves three major steps: 

1. Installing the Fusion Middleware Infrastructure 

2. Installing Oracle Business Intelligence binaries 

3. Configuring Oracle Business Intelligence 

Installing Fusion Middleware Infrastructure 

Refer to “Installing and Configuring the Oracle Fusion Middleware Infrastructure 12c” for more 

information. You only need to install the infrastructure. Configuration is not needed at this point. 
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Installing Oracle Business Intelligence Binaries 

Refer to “Installing Oracle Business Intelligence” under Fusion Middleware Installing and 

Configuring Oracle Business Intelligence 12c for complete details. 

Configuring Oracle Business Intelligence 

Refer to “Configuring Oracle Business Intelligence” under Fusion Middleware Installing and 

Configuring Oracle Business Intelligence 12c for complete details. 

Configuring OBIEE for Oracle FTI 

Once you successfully installed OBIEE, complete this section to deploy the Oracle FTI components 

(metadata & reports). This section also contains details on the various other configurations required in 
the OBIEE and OTM applications to complete the Oracle FTI deployment. Please perform the 

configuration steps in the following sequence: 

1. Creating RPTAPP and OLTP Database Connections 

2. Deploying Metadata to OBIEE 

3. Downloading the RPD for editing 

4. Configuring FTI Metadata Repository 

5. Deploying FTI Metadata Repository to OBIEE 

 

Creating RPTAPP and OLTP Database Connections 

On the OBIEE server, create two new database connections with the name RPTAPP and OLTP: 

 RPTAPP should connect to the Oracle FTI historical database. 

 OLTP should connect to OTM database. 

To do this, complete the following: 

1. Open the 

<OBIEE_INSTALL_PATH>\user_projects\domains\bi\config\fmwconfig\bienv\core\tnsna

mes.ora file.  

Note: Only complete these steps in the exact tnsnames file listed above. In case the file is 
not present in the admin folder, copy it from the sample folder (admin\sample) and replace 

the information inside the tnsnames.ora file with the ones mentioned below. 

2. For a standard database connection, add the following into the tnsnames.ora file: 

RPTAPP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <FTI HD Host>)(PORT = <FTI HD Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <FTI HD SID>) 

  ) 

) 

 

OLTP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 
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    (ADDRESS = (PROTOCOL = TCP)(HOST = <OTM OLTP DB Host>)(PORT = <OTM OLTP 

Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <OTM OLTP DB SID>) 

  ) 

) 

3. For a standard database connection, update the following entries to correspond with your FTI 

configuration: 

a. Under RPTAPP, set the following: 

i. (HOST =<FTI HD Host>) should be the FTI DB server name. 

ii. (SID = <FTI HD SID>) should be the FTI DB SID. 

iii. (PORT = <FTI HD Port>) should be the FTI DB Port. 

b. Under OLTP, set the following: 

i. (HOST =<OTM OLTP DB Host>) should be the OTM DB server name as 

determined during the OTM install. 

ii. (SID = <OTM OLTP DB SID>) should be the OTM DB SID as determined during 

the OTM install. 

iii. (PORT = <OTM OLTP Port>) should be the OTM DB Port as determined during 

the OTM install. 

4. For a RAC database connection set the RPTAPP as shown below: 

RPTAPP = 

(DESCRIPTION = 

(ADDRESS = (PROTOCOL = TCP)(HOST = <RAC SCAN LISTENER ADDRESS>)(PORT = <SCAN 

LISTENER PORT NUMBER>)) 

(CONNECT_DATA =  

(SERVER = DEDICATED) 

(SERVICE_NAME = <RAC SERVICE NAME>)) 

) 

a. Under RPTAPP, set the following: 

i. (HOST =<RAC SCAN LISTENER ADDRESS>) should be the RAC SCAN listener 

address. 

ii. (PORT = <SCAN LISTENER PORT NUMBER>) should be the RAC SCAN listener 

port number. 

iii. (SERVICE_NAME = <RAC DB SERVICE NAME>) should be service name of the 

RAC database server. 

b. Set the OLTP up as detailed for a standard database connection. 

When OBIEE loads the Oracle Fusion Transportation Intelligence metadata, it will connect to the HD 

and OLTP databases using the RPTAPP and OTLP tnsname entries only. 

Deploying Metadata to OBIEE 

Deployment in OBIEE 12c is entirely via command line. The advanced_analytics.bar file shipped with 
FTI contains the RPD, Catalog, and security metadata bundled into bar file. The following steps can be 
used to deploy them: 

1. Navigate to <OBI_HOME>user_projects/domains/bi/bitools/bin. 

2. Run ./stop.sh to stop all servers. 

3. Start WLST from ORACLE_HOME/oracle_common/common/bin/wlst.sh. 
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4. Copy the .bar file to the server where OBIEE is installed. 

5. Use the following command in WLST to import the BAR file into the new OBIEE 12c instance: 

a. importServiceInstance('/Middleware/user_projects/domains/bi','ssi','/tmp/advanced_a

nalytics.bar',true,true,true,'transportationintelligence1') 

b. The parameters used above in order are as follows: 

i. DOMAIN_NAME – Domain configured for OBIEE 

ii. SERVICE INSTANCE – ssi by default 

iii. BAR FILE LOCATION 

iv. IMPORT RPD 

v. IMPORT CATALOG 

vi. IMPORT SECURITY MODEL 

vii. PASSWORD – transportationintelligence1 is shipped by default 

6. Once the import is done, start the serves using ./start.sh. 

 

Downloading the RPD for Editing 

The RPD needs to be downloaded for changing the schema passwords in the connection details. Please 

use the following steps to download the RPD: 

1. Navigate to <OBI_HOME>user_projects/domains/bi/bitools/bin. 

2. ./datamodel.sh downloadrpd -O advanced_analytics.rpd -SI ssi -U weblogic -P <weblogic 

password> 

3. The downloadrpd parameter denotes that the RPD is being downloaded. 

4. –SI denotes services instance and –U, -P parameters require the weblogic username and 

password set at the time of configuration. 

Once executed, the command will prompt for the RPD password. This password can be any 
password that is desired. Please make a note of this password as it will be needed while 
deploying this RPD back into the system. 

Configuring FTI Metadata Repository 

Before redeploying the FTI repository file, you must configure it to connect to the FTI historical 
database and the OTM OLTP database. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

To configure these connections, complete the following: 

1. Using BI Administration Tool, open the advanced_analytics.rpd in offline mode. 

2. In Physical Layer, expand each database definition and in each connection pool specify the 

following: 

a. HDOWNER database user’s password where HDOWNER user is set 

b. GLOGDBA database user’s password where GLOGDBA user is set 

3. Save the RPD. 

4. Select No when prompted for Global Consistency. 
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Deploying FTI Metadata Repository to OBIEE 

In 12c, deploying the RPD is entirely via command line. Once the RPD is downloaded and the 

connection details set, the following steps can be used for deployment: 

1. FTP copy your RPD to the OBIEE server. 

2. Navigate to <OBIEE INSTALL PATH>/user_projects/domains/bi/bitools/bin. 

3. In the command line, give ./datamodel.sh uploadrpd -I advanced_analytics.rpd -SI ssi -U 

weblogic -P <weblogic password>. 

4. The datamodel.sh command is used to upload the rpd.  

5. The uploadrpd parameter denotes that the RPD is being uploaded to the system. 

6. The name of the RPDis given for the –I parameter. 

7. The default service instance name is ‘ssi’ which is given for the –SI parameter. 

8. –U and –P require the weblogic username and password to be specified (set at the time of 

configuration). 

9. While executing the command, it asks for the RPD password. The default password for the 
shipped RPD is ‘transportationintelligence1’. If changed by the customer, please use the 

changed password. 

10. Once the command is successful, the system will be ready and no restart is needed. 

 

With this step, you have completed all the configuration steps in OBIEE. 

Note: To test if FTI is successfully configured, browse to the following URL: 

http://<obieeserver>:9502/analytics 

Enabling Write Back in OBIEE and FTI 

To allow FTI users to enter values for targets directly into FTI dashboards and reports, you must 
enable the write back functionality in OBIEE and FTI. To do this, you must complete two main steps: 

 Copy the write back templates provided with the FTI install to your OBIEE installation. 

 Edit the instanceconfig.xml file to enable write backs. 

 

Copying the Write Back Templates 

To achieve write back capability from dashboards, write back templates are required. These templates 
are XML files which contain physical SQL queries that interact with the write back reports and allow 
users to enter values into the database directly. FTI ships with three write back template files: 

 update_targets.xml 

 insert_targets.xml 

 delete_targets.xml  

Each template is required for a specific aspect of the write back feature as indicated by the name of 
the templates. To copy these templates, complete the following: 

1. Copy the files update_targets.xml, insert_targets.xml, and delete_targets.xml 

available in the OTM directory below: 

<otm_install_path>/fti/ 

to the following OBIEE directory: 
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<OBI_INSTALL_PATH>/user_projects/domains/bi/bidata/components/OBIPS/custommessages 

Note: In certain cases the custommessages folder may not exist in which case it has to be 

created manually and the files copied to it. 

Editing the instanceconfig.xml File 

Next, you need to edit the instanceconfig.xml file to enable the write back functionality in OBIEE. 

1. Modify the instanceconfig.xml as follows: 

a. Open the file: 

<OBI_INSTALL_PATH>/user_projects/domains/bi/config/fmwconfig/biconfig/OBI

PS/instanceconfig.xml 

b. Change the following tag <LightWriteback>false</LightWriteback> to true: 

<LightWriteback>true</LightWriteback>. 

Note: If the .xml file does not contain the tag, add it manually to 

<ServerInstance></ServerInstance>: 

<LightWriteback>true<LightWriteback>. 

2. Save the changes to the instanceconfig.xml file. 

 

Enabling Maps in OBIEE and FTI 

Editing the Mapviewer config XML File 

1. Log in to the MapViewer console at <hostURL>:<port>/mapviewer as the weblogic user. 

2. Click the Configuration link in the left pane. 

3. Under Predefined Data sources, enter the following: 

<map_data_source name="obiee_maps" 

jdbc_host="<analytics_host_url> " 

jdbc_sid="<sid>" 

jdbc_port="<port>" 

jdbc_user="hdowner" 

jdbc_password="!<hdowner password>" 

jdbc_mode="thin" 

number_of_mappers="3" 

allow_jdbc_theme_based_foi="false" 

editable="false" 

/> 

Note:  

a. You must prefix the password with an exclamation mark (!). This will encrypt the 

password. 

b. Retain the data source name of obiee_maps as FTI is configured to use that name by 

default. 

4. Click on Save and restart for the configuration to take effect. 

5. Change datasource name in <mds_config> tag  to obiee_maps: 

<data_source name="obiee_maps"> 

       <allow_predefined_themes>true</allow_predefined_themes> 

       <allow_dynamic_themes>true</allow_dynamic_themes>   

    </data_source> 
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Configuring OTM for Oracle FTI 

OTM Properties 

After successfully installing and configuring ODI and OBIEE, append the following properties to the 

CUSTOM property set: 

Table 4-3 

Key Value Description 

aa_webserver http://myfti.my.com:7001 Specify the complete URL of the 
OBIEE server along with the port 
number. If setting up reverse 
proxy server (the recommended 

approach), specify the HTTP 
Server here. See Configuring the 
OTM HTTP Server’s Proxy 

Settings for more details. 

Be sure to include the http:// or 
https:// as applicable. 

As OTM does not pass through 
the URL on an internal DNS 
name, you will need to open a 

firewall IP and port so that OTM 
can call the external fully 
qualified domain name (FQDN). 
After the changes are made, you 

will need to restart the OTM web 
server. 

ALLOW_ADVANCED_ANALYTICS true Enables/disables the Fusion 
Transportation Intelligence (FTI) 
option in OTM. 

glog.database.fti.password  Oracle FTI database password 

glog.security. 
userSession.enabled 

false To enable navigation from 
Oracle Transportation 
Management to Fusion 
Transportation Intelligence 
without an external single sign 

on (SSO) solution, set this 
property to "true" on the Oracle 

Transportation Management web 
server. 

The default is false. 

See the Oracle Transportation 
Management Security Guide for 
complete details about enabling 
single sign on. 
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Key Value Description 

glog.odi.agent.server  Host name of the server running 
the ODI agent 

glog.odi.agent.port  Port number of the server 
running the ODI agent 

glog.odi.password <SUPERVISOR password> Password of the ODI login user. 
Refer to the ODI installation 
documentation for more 
information on this password. 

glog.odi.work.repository.code FTI_WORK Specify the name of the FTI 
work repository deployed in the 

ODI server. You set this up 
earlier in the installation 
process. 

Note: 
glog.odi.work.repository.code is 

the Work Repository Name that 
you specified while creating the 
work repository. 

glog.odi.email.from.address ftiadmin@yourdomain.com Specify from e-mail address to 
send ETL results. 

 

Note these properties can be set in the Custom Properties section of the glog.properties file. See 
the Custom Properties section of the Administration Guide for more information. 

Also set the following properties in the glog.properties file: 

Table 4-4 

Key Value Description 

glog.database.fti.dbserver ftihost.mycompany.co
m 

Fully qualified domain name of 
the Oracle FTI database 

glog.database.fti.port 1521 Port that Oracle is using on the 
Oracle FTI database server 

glog.database.fti.sid  Oracle FTI database service 
name 

 

6.  

Configuring FTI Support of URL Redirects on OTM Shipment IDs 

To facilitate looking-up of corresponding shipments in OTM, FTI reports support URL redirects on 

shipment IDs. To build the URL, FTI uses the parameter OTM_WEB_SERVER that can be configured in 
OTM. 
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To configure this in OTM, complete the following: 

1. Log into OTM as DBA.ADMIN. 

2. Navigate to Business Process Automation > Power Data > Document Generation > 

Report Common Properties. 

3. Edit the property OTM_WEB_SERVER. 

4. Change the default value from data content to the correct OTM URL which will be similar to the 

one shown below: 

 http://<OTM Hostname>/GC3 

 

For example: http://myhost.mydomain.com/GC3 

5. Click Finish to complete the configuration change in OTM. 

6. For this configuration change to reflect in FTI, the ROD refresh job (if a ROD is in use) must be 

executed.  

 

If a ROD is not in use this step is not applicable. 

7. Run the ETL for the changes to transfer to the historical database. 

8. Restart the OBIEE services and then access the FTI Dashboard Reports. 

Note: This configuration step must be done when configuring FTI for the first time to the 

OTM application or whenever the OTM application’s web server is modified. 

Deploying Multiple RPDs in a Single OBIEE11g Installation 

This section provides instructions how to deploy two repository (RPD) files in a single installation of 
OBIEE. For complete details on the OBIEE installation, see the ORACLE® FUSION MIDDLEWARE 

INSTALLATION GUIDE FOR ORACLE BUSINESS INTELLIGENCE 11G RELEASE 1 (11.1.1), chapter 2 
Recommended Installation Scenarios for Oracle Business Intelligence. Specifically, refer to the 

sub section 2.2.3.2 Installing Multiple, Standalone Oracle Business Intelligence Instances on 
a Single Computer. 

You can establish multiple instances of OBIEE on single installation of OBIEE on the same computer. 
In this process, an additional WebLogic domain is created which establishes the connection between 

Oracle BI Home and the second instance of OBIEE. 

Pre-requisites: 

Installation of OBIEE on the machine has already been completed. As a result, you have an OBIEE 
directory, which already has an instance generated, and OracleBI Home directory. 

Generating a Second Instance of OBIEE 

Complete the following steps to generate a second instance of OBIEE in single OBIEE installation 
directory: 

1. Create new schema using the RCU utility for the new instance. 

o Run the command rcu.bat to create the new schema. 

2. Run the batch file config.bat present in the path below to use the Configuration Assistance to 

generate another instance of OBIEE: 

o Middlewarehome > OracleBI1>bin>config.bat 

3. Click Next until you see a window to select Create New BI System. 

4. Select the Create New BI System option. 



Copyright © 2001, 2020, Oracle and/or its affiliates. All rights reserved. 4-29 

5. Enter a different name for Domain Name.  

 

For example: bifoundation_domain2 

6. Enter the WebLogic user name and password. 

7. Click Next. 

8. Click Next again. 

9. Enter the Connect string. 

10. Enter the schema name and password created using RCU in first step for BIPLATFORM 

Schema_Username and password. 

11. Click Next. 

12. Enter the same schema name and password created using RCU in first step for MDS_SCHEMA. 

13. Click on Next until you see a window which contains the Configure button. 

14. Click the Configure button. 

15. Click Finish. 

Now the second instance of OBIEE is generated in the same OBIEE installation directory. To verify the 
instance was generated, go to the following path: 

 Middlewarehom > instances 

After following the above mentioned steps, the following URLs are generated to access both of the 
instances: 

Instance1     Instance2 

 http://localhost:7001/em   http://localhost:7002/em 

 http://localhost:7001/analytics       http://localhost:9704/analytics 

 http://localhost:7001/console   http://localhost:7002/console 

This allows you to utilize two individual instances of OBIEE to host two different RPDs and their 
respective web catalog files using the respective URLs for each instance. 

Note: It is recommended to open the URLs of both instances in separate browsers.  

Manually Merging FTI and OBIA 

This section details how to manually merge FTI with Oracle Business Intelligence Applications (OBIA). 

The merging process is comprised of the three steps listed below. 

 Manually Merging OBIA Metadata with FTI Metadata 

 Manually Merging the OBIA Web Catalog with FTI Web Catalog 

Prerequisites 

The following are required prior to completing the merge process: 

 OTM is already installed. 

 FTI is installed and configured except for the OBIEE deployment which is covered in the 

section titled “Deploying FTI Metadata Repository & Web Catalog to OBIEE”. 

 OBIA is already installed on this machine. 
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Manually Merging OBIA Metadata with FTI Metadata 

Important Note: Manually merging RPDs is possible. However, these changes result in a 
non-standard installation. Oracle only supports issues reported on a stand-alone FTI 

installation. Therefore, Oracle Product Support requires users to replicate any issue in a 

non-merged FTI environment prior to reporting the issue. 

Next, you need to manually merge the FTI metadata and the OBIA metadata. 

For detailed steps, refer to the section “Merging Repositories” -“Performing Full Repository Merges 
without a Common Parent” in the Oracle Business Intelligence Enterprise Edition 11g documentation. 

Note: RPDs created in a newer version of OBIEE/OBIA are not backward compatible! You 
must always merge UP to the higher version of OBIA. For example, if you have two RPDs 

and the FTI RPD is in version 11.1.1.6.8 and the OBIA RPD is version 11.1.1.7, you can 

only merge those RPDs in version 11.1.1.7. The FTI 6.3.2 RPD uses OBIEE 11.1.1.6.8. 

Note: The RPD can only be opened on a Windows machine. See the System Requirements 

and Supported Platforms for Oracle® Business Intelligence Suite Enterprise Edition > Client 

Environment Requirements. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

Prerequisites 

The following variables should be changed before starting the merge process. There are several 

objects variables that overlap between OBIA and FTI. You need to rename several duplicate variables 

for use by FTI as shown below: 

1. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 

All Programs >Oracle Business Intelligence > BI Administration 
 

OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

2. Open the FTI RPD using the BI Admin tool. Go to File > Open > Offline. 

3. Provide the password when prompted. 

4. Navigate to Manage > variables > Repository > Dynamic. 

5. Locate the variables CURRENT_MONTH, CURRENT_WEEK, CURRENT_YEAR, and 

CURRENT_QUARTER. 

6. Rename these variables as shown in the table below. 
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Table 4-4 

Sequence 
Number 

Object Type Object Description 

1 Repository 
Variable 

CURRENT_MONTH There is a conflict with the 
CURRENT_MONTH object in the FTI RPD and 

the identically named variable is in the OBIA 
RPD. You must rename the FTI variable to 
end with FTI (CURRENT_MONTH_FTI). 

2 Repository 
Variable 

CURRENT_WEEK There is a conflict with the CURRENT_WEEK 
object in the FTI RPD and the identically 
named variable is in the OBIA RPD. You 

must rename the FTI variable to end with 
FTI (CURRENT_WEEK_FTI). 

3 Repository 
Variable 

CURRENT_QUARTER There is a conflict with the 
CURRENT_QUARTER object in the FTI RPD 
and the identically named variable is in the 

OBIA RPD. You must rename the FTI 
variable to end with FTI 
(CURRENT_QUARTER_FTI). 

4 Repository 
Variable 

CURRENT_YEAR There is a conflict with the CURRENT_YEAR 
object in the FTI RPD and the identically 
named variable is in the OBIA RPD. You 

must rename the FTI variable to end with 
FTI (CURRENT_YEAR_FTI). 

7. Save and close the FTI RPD. 

8. Open the OBIA RPD. 

9. Navigate to Manage-Variables > Session > Variables > System. 

10. Locate the variables USER and loglevel. 

11. Delete both variables. 

Table 4-5 

Sequence 
Number 

Object Type Object Description 

5 Session Variable LOGLEVEL LOGLEVEL has conflicts, OBIA log level has been 
removed 

6 Session Variable USER USER has conflicts, OBIA USER has been removed 

 

Note: If you have updated the OBIA RPD to Authenticate and Authorize the users then 

follow these additional steps: 

12. IF OBIA is using the external table authentication mechanism: 

a. Update the initialization block in Manage > Variables > session > Initialization blocks 

> Authenticate. 

b. Change the query so that the user is authenticated for both FTI and OBIA. 
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13. IF OBIA is using ‘ROLES’ variable from RPD to get the ‘ROLES’: 

a. Change the initialization block in Manage > Variables > session > Initialization blocks 

> GET_USER_ROLE.  

b. Changes the query so that the ROLES get assigned for both FTI and OBIA. 

 

Running the Merge Repository Wizard: 

Now, you are ready to run the Merge Repository wizard as follow: 

1. If using a Linux/Unix machine, you must first copy 

<otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the BI 

Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA RPD or Customer-defined RPD to 

the Windows system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA RPD or Customer-defined RPD, please contact 

your OBIEE/OBIA administrator. 

3. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 
 

All Programs >Oracle Business Intelligence > BI Administration 

 
OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the BI Administration tool installed and open the BI Administration tool. 

4. Create a new blank repository which will be used during the merge process: 

a. Create a new repository with no contents. 

b. Save it as blank.RPD in a folder. 

5. Open the OBIA RPD via File >Open.  

6. Navigate to File > Merge.  

 

The Merge Repository Wizard opens. 

7. In the Merge Repository Wizard, choose the following options: 

a. Select a Merge Type: of Full Repository Merge. 

b. For Original Master Repository:, select the newly created blank.rpd. 

c. For Modified Repository:, choose the FTI RPD which is titled 

advanced_analytics.rpd. 

d. For Current Repository:, choose the OBIA RPD. 

e. Save the Merged Repository with the name merged rpd. 

8. Click Next. 

9. In the Decision field choose all the Decisions to be current. 

a. Selecting Current keeps the object from the current repository. This is what you must 

select. 

b. If you select Modified, objects are deleted. You should NOT select Modified. 

10. Click finish. 
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Note: After completing the merge, you may notice that not all components in OBIA RPD 

have transferred to the merged RPD but all components of FTI RPD have transferred. There 

may be empty folders in physical layer that are not being transferred to the merged 

metadata. You can ignore these empty folders they will have no impact on the reports. 

Manually Merging the OBIA Web Catalog with FTI Web Catalog 

In this procedure, the OBIA dashboards and reports are merged with the FTI dashboards and reports. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network.  

Note: This must be a Windows system since the BI Administration tool and Catalog 

Manager is only available for Windows. 

Merging the FTI and OBIA Web Catalogs 

1. If using a Linux/Unix machine, you must first copy <otm_install_path>/fti/aa which is the 

FTI web catalog to the Windows system where the BI Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA web catalog to the Windows 

system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA web catalog, please contact your OBIEE/OBIA 

administrator. 

3. Open the Catalog Manager: 

a. Windows ONLY: Open the catalog manager in windows by running either of the 
following: 

 

All Programs ->Oracle Business Intelligence -> Catalog Manager 

 

OR 

 
OBIEE_HOME\instances\instance\bifoundation\ 

OracleBIPresentationServicesComponent\ 

coreapplication_obips1\catalogmanager\runcat.cmd 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the Catalog Manager installed and open the Catalog Manager. 

4. Select File > Open catalog. 

5. Open the OBIA web catalog in offline mode. 

6. Open another window of Catalog Manager. 

7. Open the FTI web catalog, aa, in the new window. 

8. Copy the shared folder from the FTI web catalog, aa. 

9. Paste it into the OBIA web catalog. 

Note: After pasting the shared folder in the OBIA Catalog in Catalog Manager window, an 

error alert appears with no description. If you click on details button, it shows as 

a“java.lang.NullPointerException” error. You can ignore this error. No errors are seen in 

end reports due to this error. 

Deploying the New OBIA Web Catalog 

1. Linux Only: Copy the newly merged web catalog back to your linux system so that you can 

load the new catalog. 

2. Load the merged catalog in OBIEE server as follows: 
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a. Open WebLogic Enterprise Manager (http:<weblogic_host>:<port>/em). 

b. Navigate to Business Intelligence > Coreapplication > deployment > 

Repository > Catalog Location. 

c. Provide the location of the merged OBIA web catalog. 

d. Restart the WebLogic server. 

Note: Refer the following document to restart the WebLogic server “Oracle® Fusion 

Middleware System Administrator's Guide for Oracle Business Intelligence Enterprise 

Edition11g Release 1 (11.1.1)” section 4 Starting and Stopping Oracle Business 

Intelligence. 

Redefining the Catalog Roles for the FTI Dashboards and Reports 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders > FTI Reports >Dashboards. 

3. Click on More on the side of the specific dashboard. 

4. Go to permission. 

5. Apply the permissions for each dashboard as defined in the Business Intelligence Roles 

matrix in the OTM help. To find this help topic,  

a. Log into OTM and go to Help > Help. 

b. Click the Search tab. 

c. Search for Business Intelligence Roles. 

d. Click the link to the Business Intelligence Roles help topic. 

e. Refer to the table in that help topic. 

6. Repeat these steps for all of the dashboards. 

7. Navigate to Administration >Manage Privileges. 

8. Deny the access for ‘NO ACCESS’ role to the Dashboard. 

9. Deny the access for ‘NO ACCESS’ and ‘LSP CUSTOMER’ role to the Answers. 

Note: The permissions given for the OBIA Catalog objects are different from what exist in 

FTI. For example, in OBIA only the BIAuthor role can see the Ad-hoc query .But in FTI, the 

BiConsumer role can see the Ad-hoc query. Please refer to the FTI Reference Guide section 
titled FTI Privileges to see a list of all the objects in OBIEE and the permissions given for 

them in FTI 6.3.2. This may or may not vary from OBIA catalog. So if you see any 

variation, you need to change the permissions in merged catalog to align with FTI. 

Updating the FTI Prompts with New Variables 

Finally, you need to change the FTI prompts which have the older variables CURRENT_MONTH, 
CURRENT_WEEK, CURRENT_QUARTER, and CURRENT_YEAR to use the new prompts of 
CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, and CURRENT_YEAR_FTI as 

defined in the RPD. 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders >FTI Dashboard Prompts. 

3. Edit the following dashboard prompts and change the default variables given there to the FTI 

specific variables of CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, 

and CURRENT_YEAR_FTI. 

a. /shared/FTI Dashboard Prompts/YQMW Prompt 

b. /shared/FTI Dashboard Prompts/YQMW Horizontal Prompt 

c. /shared/FTI Dashboard Prompts/YQMW With Week Horizontal Prompt 
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d. /shared/FTI Reports/FTI Sample Reports/FTI Deprecated Reports/YQMW With Week 

Horizontal Prompt 

e. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Invoice Cost 

Type Prompt 

f. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Shipment 

Cost Type Prompt 

g. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/Shipment 

Order Release Cost Type Prompt 

h. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW Order 

Analysis  Prompt 

i. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW Quote 

Analysis Prompt 

j. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Analysis Prompt 

k. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Claims Prompt 

l. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Event Analysis Prompt 

m. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Order Release Line Prompt 

n. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Order Release Prompt 

o. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Stop Analysis prompt 

p. /shared/FTI Reports/FTI Sample Reports/FTI Sample Dashboard Prompts/YQMW 

Shipment Stop Delivery Analysis prompt 

q. /shared/FTI Dashboard Prompts/Network YQMW Prompt 

 

Creating New FTI Reports 

It is recommended that you create any new FTI reports by opening the Ad Hoc Query link 
(Transportation Intelligence > Ad Hoc Query) in a new window. This will allow all OBIEE features to 
work properly.  

The other recommendation is to set up a reverse proxy in OTM HTTP Server for OBIEE WebLogic 

server as follows. 

Configuring the OTM HTTP Server's Proxy Settings: 

1. Open OTM HTTP Server's mod_wl_ohs.conf file. 

2. Insert the following proxy request information into the configuration file: 

 ProxyRequest Off 

 <Proxy*> 

   Order deny,allow 

   Allow from all 

 </Proxy*> 

 Location/Oracle BI EE subdirectory 

   ProxyPass http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

   ProxyPassReverse http://location of Oracle BI EE server/ 
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      Oracle BI EE subdirectory 

 /Location 

3. Save and close the configuration file. 

4. Test the configuration by using a fully-qualified name to log into Oracle's OBIEE through 

Oracle HTTP Server. 

Installing Other Languages for Oracle FTI 

The translated file for FTI metadata and reports are available as part of an update to 6.3 and these 
files need to be installed as explained in the following sections. 

Installing Other Languages for Oracle FTI Metadata 

Once you have downloaded the update containing the FTI metadata files for other languages, follow 

the procedure below to install them. 

Note: The other languages content for Oracle FTI metadata will be shipped as csv files with 

the names w_localized_string_g_<lang id>.csv available under the directoy 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

1. On the OTM server, go to the directory <otm_install_path>/glog/oracle/script8. 

2. Load other languages for the Oracle FTI metadata data by running update_content_aa. This 

process is run at the host command line rather than from within SQL*Plus. Two command 

scripts are provided and the script you use is dependent on your operating system: 

a. UNIX shell script run: 
 

./update_content_aa.sh <otm_install_path>/glog/config 

b. Windows command line script run: 

 

update_content_aa.cmd <otm_install_path>\glog\config 

3. Review the log file called update_content_<db sid>_<timestamp>.log for errors.  

 

This file is located in the same directory as the SQL script.  
 

Look for errors by searching key words like “ORA-“, “Caught exception”,”SP2-“, or “<Error>“ 

within the log file. 

Installing Other Languages for Oracle FTI Reports 

Once you have downloaded the update containing the FTI report files for other languages, follow the 
procedure below to install them. 

Note: The other languages content for Oracle FTI reports will be shipped as XML files 

available in language-specific folders under the directory 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics. 

1. On the OTM server, go to the directory 

<otm_install_path>/glog/oracle/script8/content_advanced_analytics 

2. Copy the following folders containing the other languages translation XMLs for Oracle FTI 

reports: 

 l_de 

 l_en 

 l_es 
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 l_es-mx 

 l_fr 

 l_fr-ca 

 l_it 

 l_ja 

 l_ko 

 l_pl 

 l_pt-br 

 l_ru 

 l_tr 

 l_zh-cn 

 l_zh-tw 

 l_th 

o (note: The Thai translations will not be available as a post-release patch) 

3. On the OBIEE server, stop the OBIEE services. 

4. On the OBIEE server, place the copied folders (in Step 2) to the following directory:  
 

ORACLE_INSTANCE\bifoundation\OracleBIPresentationServicesComponent\coreapplicat

ion_obipsn\msgdb\l_xx 

Note: The ‘xx’ in the folder of l_xx may be any language listed above. For example for French, 
the folder should be l_fr. If this folder does not exist, you should create one as shown below: 
instances\instance1\bifoundation\OracleBIPresentationServicesComponent\coreappl

ication_obipsn\msgdb\l_fr 

5. On the OBIEE server, start the OBIEE services. 

After successfully installing the languages for Oracle FTI, use the Language preference under the User 
Preferences in OTM to specify the users preferred language. 
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5. Installing Global Trade Intelligence (GTI) 

OTM delivers the Oracle Global Trade Intelligence (GTI) solution which includes the following 
components.  

 Oracle Trade Intelligence Extract Transform & Load (ETL): Pre-packaged ETL process deployed 

on an Oracle Data Integrator (ODI) instance 

 Oracle Global Trade Intelligence Historical Database (HD): The analytics database for the 

Oracle Global Trade Intelligence applications 

 Oracle Global Trade Intelligence Metadata: Delivered as advanced_analytics.rpd file 

 Oracle Global Trade Intelligence Canned Reports: Delivered as aa_webcat.zip 

For more details about these components and Oracle GTI, see the Oracle Global Trade Intelligence 
Reference Guide. 

Important Note: Many script names, file names, repository names, and user names used 

during the installation and created by the installation contain the word FTI. This is correct 

since GTI was designed as a part of FTI.  

Note: Prerequisites for installing Oracle GTI are that you have experience with installing 

Oracle databases, OTM/GTM administration, OBI EE administration, ODI administration, 

and experience with Oracle ETL. 

Installing Oracle GTI Historical Database (HD) 

Replicated Operational Database (ROD) Considerations 

The deployment architecture of Oracle GTI supports the following deployment choices for customers: 

1. Load Historical Database using ROD 

 

In this deployment, a ROD (that maintains a snapshot of the OTM OLTP database) is used. The 
Oracle FTI/GTI ETL jobs will connect to the ROD to load the Historical Database thereby de-

coupling the OTM OLTP database from the ETL process. 

2. Load Historical Database using OLTP (Online Transaction Processing Database). 

 
In this deployment, the Oracle FTI/GTI ETL jobs will connect directly to the OTM OLTP 

database to load the Historical Database adding to additional database workload on the OTM 

OLTP database. 

It is strongly recommended that you use a ROD to achieve performance gains and to efficiently 
balance the load on the OTM OLTP database. 

Historical Database (HD) Considerations 

The Historical Database (HD) schema can be created on a separate database. This schema can also 
share the ROD or the OLTP database. 

Creating Historical Database (HD), Users, and Packages 

Note: All users for GTI will start with “fti” and all OTM properties also contain “fti”. This is 

not a mistake since GTI is part of FTI. 

For details on creating the HD, users and packages, see “CREATING HISTORICAL DATABASE (HD), USERS, AND 

PACKAGES” in the section “INSTALLING ORACLE FUSION TRANSPORTATION INTELLIGENCE (FTI)”. 
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Installing Oracle Data Integrator (ODI) 

Certain files required for Oracle Data Integrator installations are available under 

<otm_install_path>/fti. If Oracle Data Integrator is installed on a different server than OTM, please 

copy these files to a folder where the installing user has write permissions. 

Note: The minimum settings required for installing Oracle Data Integrator for Oracle GTI 

are listed below. Refer to the Oracle Data Integrator Installation Manual for detailed 

instructions on how to install Oracle Data Integrator. 

Note: Installing the ODI agent in the database tier provides better performance than 

installing it in the application tier. 

Prerequisites: JDK version 1.8 installed. Refer to 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-

configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1 for installing 

JDK. 

Install Oracle Fusion Middleware Infrastructure 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/infin/index.html for installing 

Oracle Fusion Middle Infrastructure. 

3. Launch the installation program by invoking the java -jar from the JDK directory on your 

system as shown in the examples below: 

 On UNIX operating systems:  

 
/home/Oracle/Java/jdk 1.8.0_211/bin/java -jar 

fmw_12.2.1.4.0_infrastructure.jar 

 On Windows operating systems:  

 
C:\Program Files\Java\jdk 1.8.0_211\bin\java -jar 

fmw_12.2.1.4.0_infrastructure.jar 

Note: Be sure to replace JDK file location in these examples with the actual JDK location on 

your system. 

4. On the Welcome screen of the Oracle Fusion Middleware Infrastructure installation wizard, 

click Next >. 

5. On the Installation Location screen, specify the location of your Oracle home directory. 

6. Click Next >. 

7. On the Installation Type screen, select Fusion Middleware Infrastructure. 

8. Click Next >. 

9. On the Prerequisite Checks: verify that your system meets the minimum necessary 

requirements.  
 

If you get warning or error message, please following instructions in message. 

10. Click Next >. 

11. On Installation Summary screen, verify the installation options you selected.  

12. Click Install >. 

13. You see an Installation Progress screen which allows you to see the progress of the 

installation. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/preparing-install-and-configure-product.html#GUID-8AA3A3BA-27F0-43B8-8F62-1B2DC8C5DBB1
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/infin/index.html
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14. On the Installation Complete screen, review the information on this screen and click Finish to 

complete the installation. 

Installing Oracle Data Integrator 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-
software.html for installing Oracle Data Integrator.  

1. Launch the installation program by invoking the  java –jar from the JDK directory on your 

system, as shown in the examples below: 

o On UNIX operating systems: 

 

/home/Oracle/Java/jdk 1.8.0_211/bin/java -jar fmw_12.2.1.4.0_odi.jar 

o On Windows operating systems: 
 

C:\Program Files\Java\jdk 1.8.0_211\bin\java -jar fmw_12.2.1.4.0_odi.jar  

Note: Be sure to replace JDK location in these examples with the actual JDK location on 

your system. 

2. On the Welcome screen installation wizard, click Next >. 

3. On the Installation Location screen, specify the location of your Oracle home directory. 

Note: Specify same oracle home location as middleware infrastructure oracle home. 

4. On the Installation Type screen, select installation type of Enterprise Installation. 

5. Click Next >. 

6. On the Prerequisite Checks screen verify that your system meets the minimum 

necessary requirements. 

Note: If there are any warnings or error messages, refer to the ODI installation 

documentation referenced above. 

7. Click Next >. 

8. On the Specify Security Updates screen, choose how you want to be notified about security 

issues: 

a. If you want to be notified about security issues through email, enter your email 

address in the Email field. 

b. If you want to be notified about security issues through My Oracle Support, select the 

My Oracle Support option. Enter your email address in the Email field and enter your 

My Oracle Support Password. 

c. If you do not want to be notified about security issues, clear the check box and leave 
all fields empty. 

 

You will see the following message: "My Oracle Support Username/E-mail address not 

specified". 

d. Click Yes to continue. 

9. Click Next >. 

10. On the Installation Summary screen, verify the installation options you selected.  

11. Click Install >. 

12. Use the Installation Progress screen to view the progress of the installation. 

 

The Installation Complete screen appears when the installation is complete. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-software.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/installing-product-software.html
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13. Review the information on the Installation Complete screen, and click Finish to dismiss the 

installer. 

 

Configuring ODI for Oracle GTI ETL 

Note: All ODI users and repositories for GTI will start with “fti” and all OTM properties also 

contain “fti”. This is not a mistake since GTI is part of FTI. 

Creating a New Oracle Data Integrator Repository Login 

Next, you create a login to connect to the Oracle Data Integrator repository. 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/oracledi/client/odi.exe or 

c. In Linux, run <ODI_HOME>/oracledi/client/odi.sh 

Note: As soon as you open ODI Studio for the first time, you are prompted for the JDK 

Home which needs to be set. 

2. Open the New Gallery by choosing File > New. 

3. In the New Gallery window, in the Categories tree, select ODI.  

4. From the Items list, select Create a New ODI Repository Login. 

5. Click OK.  
 

The Repository Connection Information Screen opens. 

6. In the Oracle Data Integrator Connection section enter the following: 

a. Login name: A generic alias (for example: DEVREP) 

b. User: SUPERVISOR (use capitals) 

c. Password: Refer to the ODI Installation Guide for the ODI SUPERVISOR user 

password and enter that here. 

7. In the Database Connection (Master Repository) section enter the following: 

a. User: ftiodimaster 

b. Password: Enter the password for ftiodimaster user. 
 

(This is the password for the ftiodimaster user that you entered when you ran the 

create_odi_users.sql script.) 

c. Drivers List: Choose Oracle JDBC Driver 

d. URL (standard server configuration only): Enter the complete JDBC URL for the 
master repository data server. 

 

For example: jdbc:oracle:thin:@<GTI DB SERVER NAME>:<GTI DB PORT>:<GTI DB 
SID> 

 

See the following properties for these settings: glog.database.fti.dbserver, 

glog.database.fti.port, and glog.database.fti.sid. 

e. URL (RAC configuration only): Enter the RAC SCAN listener address and the service 

name as part of the URL as follows: 

 
For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 
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Note: Don’t click on Test Connection button to test the connection; because the master 

repository is not yet created. 

8. In the Work Repository section, enter the following: 

a. Select the Master Repository Only option. 

b. Click OK. 

c. Select Yes to make this the default login. 

d. Click OK again. 

9. You get an alert regarding the Security wallet, asking whether you want to store the 

passwords.  
 

Select the option Store passwords without secure wallet. 

Creating the Master Repository and Importing the Artifacts  

Next, you create the tables and automatically import the definitions for the new ODI master 
repository. Due to performance, it is recommended that you have separate FTI/GTI ODI repositories 

instead of incorporating them along with other ODI applications. 

 The user completing this procedure must have write access to the folder that contains the 

FTI_ETL_TOPOLOGY.zip, FTI_ETL_SECURITY.zip, and FTI_ETL_WORK.zip files. 

 These files are available under <otm_install_path>/fti 

 If Oracle Data Integrator is installed on a different server, please copy these files to a folder 

where the installing user has write permissions. 

To create the master repository and import the artifacts, complete the following: 

1. Open ODI Studio: 

a. In the Windows Start Menu, select Programs > Oracle Data Integrator > ODI 

Studio, or 

b. Also in Windows, launch <ODI_HOME>/odi/studio/odi.exe, or 

c. In Linux, run <ODI_HOME>/odi/studio/odi.sh 

2. Select File > New to open a new gallery. 

3. In the New Gallery window, in the Categories tree, select ODI. 

4. From the Items list, select Create a New Master Repository. 

5. Click OK. 

6. In the Database Connection section, complete the following: 

a. Technology: From the list, choose Oracle. 

b. JDBC Driver: Keep the default oracle.jdbc.OracleDriver 

c. JDBC URL: Enter the analytics databse URL. 

d. User: enter ftiodimaster 

e. Password: enter ftiodimaster password 

Note: You must connect as SYSDBA so enter “sys as SYSDBA”. 

f. DBA User:<System User> 

g. DBA Password: <System User Password> 

h. Click Next. 

i. Enter SUPERVISOR password and confirm the password. 

j. Click Finish. 
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7. Click Finish to begin master repository creation. 

 

This process may take up to 10 minutes. 

8. Select the Topology tab. 

9. Click Connect to Repository. 

10. Enter the following: 

a. Login Name: Choose the login name you created. 

b. User: Enter SUPERVISOR 

c. Password: Enter SUPERVISOR’s password. 

d. Click OK. 

11. On the Topology tab, select Import > Import Topology. 

12. Click OK. 

13. Select an Import Mode of Synonym Mode Insert Update. 

14. Select Import from Zip file. 

15. Browse to and select FTI_ETL_TOPOLOGY.zip and click OK. 

16. On the Security tab, select Import > Import Security Settings.  

17. Click OK. 

18. Select an Import Mode of Synonym Mode Insert Update. 

19. Select Import from Zip file. 

20. Browse to and select FTI_ETL_SECURITY.zip and click OK. 

21. Validate the JDBC URLs for source and target databases by completing the following for each 

schema listed below: 

o ORACLE_FTI: (QA or PROD or UAT) Environment’s historical database hdowner 
schema mapped to global context. Enter the JDBC URL of the FTI production/QA/UAT 

database which contains the HDOWNER schema.  

 
See the following properties for these settings: glog.database.fti.dbserver, 

glog.database.fti.port and glog.database.fti.sid. 

o ORACLE_FTI_DEV: Development environment’s historical database hdowner schema 

mapped to development context.  
 

Note: If you do not have a development environment, you do not need to specify this 

URL. 

o ORACLE_OTM: (QA or PROD or UAT) Environment’s OTM glogowner schema mapped 
to global context. 

 

This is the JDBC URL for your OTM server. 

o ORACLE_OTM_DEV: Development environment’s OTM glogowner schema mapped to 

development context.  

 

Note: If you do not have a development environment, you do not need to specify this 
URL. If the target database is a RAC, make sure to use the SCAN listener and service 

name in the URL. 

22. To validate the URLs, complete the following for each schema listed above: 

a. Click on the Connect To Repository… link. 

b. In the Login Name list, choose the ODI repository login. 

c. Click OK. 

d. Click on Topology tab. 
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e. Go to the Physical Architecture pane and expand Technologies > Oracle. 

f. Double-click the schema name (for example, ORACLE_FTI). 

g. Click the JDBC tab. 

h. Enter the corresponding JDBC URL for each schema. 
 

The JDBC URL should be in the form of jdbc:oracle:thin:@<DB SERVER>:<DB 

PORT>:<DB SID>. See the explanations in step 9 above to determine what URL to use 

for each schema. 

23. Next, for each schema listed above make sure connection to the data server is set up correctly 

as follows: 

a. Click Definition tab. 

b. In the Connection section, for the ORACLE_FTI and ORACLE_FTI_DEV schemas, 

enter the following: 

i. User: ftiodistage 

ii. Password: <password for the ftiodistage user>. 
 

This is the password for the ftiodistage user that you entered when you ran 

the create_odi_users.sql script. 

c. In the Connection section for the ORACLE_OTM and ORACLE_OTM_DEV schemas, 

enter the following: 

i. User: glogdba 

ii. Password: <password for the glogdba user> 

 

Refer to your OTM administrator for this information. 

24. Click the Save All button. 

25. Expand Agents and double-click the OracleDIAgent agent. 

26. In the Host field, give the server name or the IP address of the machine where you 

installed ODI. 

27. Click the Save All button. 

Creating the Work Repository 

To create a work repository, complete the following: 

1. In the Topology Navigator, go to the Repositories panel. 

2. Right-click the Work Repositories node and select New Work Repository. 

3. In the Create Work Repository wizard, specify the Oracle Data Integrator work repository 

connection details as follows: 

a. Technology: Choose Oracle. 

 

The default is Oracle. 

b. JDBC Driver: oracle.jdbc.OracleDriver 

c. JDBC URL (standard server configuration only): The complete path of the data 

server to host the work repository. 

 

For example: jdbc:oracle:thin:@<FTI DB SERVER>:<FTI DB PORT>:<FTI DB SID> 

d. JDBC URL (RAC configuration only): Enter the RAC SCAN listener address and the 

service name as part of the URL as follows: 

 
For example: jdbc:oracle:thin:@<RAC SCAN LISTENER ADDRESS>:<PORT 

NUMBER>/<RAC DB SERVICE NAME> 
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e. User: ftiodiwork 

f. Password: Enter the password for ftiodiwork user. 
 

(This is the password for the ftiodiwork user that you entered when you ran the 

create_odi_users.sql script.). 

4. Click Test Connection to check the connection is working. 

5. Click Next >. 

6. Specify the Oracle Data Integrator work repository details: 

a. Name: Give a unique name to your work repository (for example: FTI_WORK). Try to 
have only letters or numbers. Don’t use special characters and spaces in between the 

words. 

b. Password: leave blank 

c. Work Repository Type: Choose Development from the list. 

Note: It is recommended that you select a Work Repository Type of Development 

since this type allows you to make changes to the work repository in the future. If 
you select a work repository type of Production, then you will not be able to edit 

the work repository. 

7. Click Finish. The Create Login dialog box opens. 

8. Click No. 

9. Click Save in the toolbar. 

Importing the Work Repository 

To import the work repository, complete the following: 

1. If you connected to the master repository only, disconnect by clicking: ODI > Disconnect 

<Login Name>. (See Creating a New Oracle Data Integrator Repository Login for this login 

name.) 

2. On the Designer tab, click Connect to Repository… 

3. On the Oracle Data Integrator Login screen, click the pencil icon to edit the Login Name. 

4. On the Repository Connection Information screen in the Work Repository section, select the 

Work Repository option. 

5. Search for and select the name that you entered in the previous section, Creating a New 

Oracle Data Integrator Repository Login. 

6. Click OK on the Repository Connection Information screen. 

7. Click OK on the Oracle Data Integrator Login screen. 

8. Connect to the work repository. 

9. From the Designer tab, click the Connect Navigator icon, then select Import > Import the 

Work Repository. 

10. Click OK. 

11. Specify an Import Mode of Synonym Mode INSERT_UPDATE. 

12. Select the Import From a Zip File check box. 

13. Choose FTI_ETL_WORK.zip.  

 
This file is located in <otm_install_path>/fti/etl/odi/. 

 

If OTM is on a different server, then chose the location where you copied this file on the ODI 

server. 
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14. Click OK to import the work repository. 

 

This process may take up to 40 minutes. Do not close or kill the process. 

Note: During this process you may get a dialog box saying that the ID <object ID> does 

not exist. Click OK to create it. 

Starting the Oracle Data Integrator J2EE Agent  

Creating J2EE Agent Repositories 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-

repository-schemas.html to create schemas. Note that you already created the ODI master and ODI 
work schemas and only need following additional schemas. 

 Audit Services(<PREFIX>_IAU) 

 Audit Services Append(<PREFIX>_IAU) 

 Audit Services Viewer (<PREFIX>_IAU_VIEWER) 

 Oracle Platform Security Services(<PREFIX>_OPSS) 

 Service Table(<PREFIX_OPSS>) 

Starting the RCU 

1. Go to the ORACLE_HOME/oracle_common/bin directory and start the Repository Creation Utility 

(RCU) as follows: 

a. Set the JAVA_HOME environment variable to your JDK location. 

i. On UNIX operating systems: setenv JAVA_HOME 

/home/Oracle/Java/<JDK_17_HOME> 

ii. On Windows operating systems: 

1. Right-click on My Computer. 

2. Select Properties. 

3. Click Advanced System Settings in the left column. 

4. Click Environment Variables in the System Properties window. 

2. In the Environment Variables window, set the system variable JAVA_HOME to your JDK 

location and click OK. 

a. On the Environmental Variables window, click OK. 

b. On the System Properties window, click OK. 

3. Start RCU as follow:  

a. Open a command prompt and enter the following: 

i. cd <ODI_Home>\oracle_common\bin 

ii. On UNIX operating systems: ./rcu 

iii. On Windows operating systems: rcu.bat 

Navigating the RCU Screens to Create the Schema 

1. On the Introducing RCU screen, click Next>. 

2. On the Create Repository screen, select System Load and Product Load Concurrently. 

3. Click Next. 

4. On the Providing Database Connection Details screen, provide the database connection 

details for RCU to connect to your database.  

5. Click Next. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-repository-schemas.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/creating-master-and-work-repository-schemas.html
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6. Click OK on the dialog window confirming that connection to the database was successful. 

7. On the Select Components screen, select Create a new prefix. 

a. Specify a customer-defined prefix. 

Note: You must make a note of the customer-defined prefix you choose to enter 

here; you will need this later on during the domain creation process. 

b. Select the Oracle Data Integrator schema. This will also select the required 

supporting Common Schemas. 
 

The customer-defined prefix is used to logically group these schemas together for use 

in this domain only; you must create a unique set of schemas for each domain as 

schema sharing across domains is not supported. 

c. Deselect Master and Work Repository as you do not need them.  

Note: These were created so do not create them again! 

d. Deselect Oracle Data Integrator schema before continuing. This will ensure that 

only the Master and Work Repository option is deselected, while the Common 

Schemas still remain selected. 

e. Click Next. 

f. Click OK on the window confirming that prerequisite checking for schema creation was 

successful. 

8. On the Specifying Schema Passwords screen, specify how you want to set the schema 

passwords on your database. 

9. Specify and confirm your passwords. 

10. On the Setting Custom Variables screen, you do not need to specify any custom variables. Just 

click Next > to continue the schema creation. 

11. Navigate through the remainder of the RCU screens to complete schema creation.  

12. In the completion screen, click Create. 

13. When you reach the Completion Summary screen, click Close to dismiss the RCU. 

Configuring the WebLogic Domain for the Java EE Agent 

Refer to https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-
agent.html to configure weblogic domain for the Java EE Agent. 

This section provides instructions for creating a WebLogic domain for your Java EE agent using the 
configuration wizard. The following topics are covered in this section: 

Starting the Configuration Wizard 

1. To begin domain configuration, navigate to the ORACLE_HOME/oracle_common/common/bin 

directory and start the WebLogic Server Configuration Wizard. 

a. On UNIX operating systems:  

./config.sh 

b. On Microsoft Windows operating systems:  

config.cmd 

Navigating the Configuration Wizard Screens to Configure the Domain 

1. Selecting the Domain Type and Domain Home Location: 

a. On the Configuration Type screen, select Create a New Domain.  

b. In the Domain Location field, specify your Domain home directory. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-agent.html
https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/oding/configuring-domain-java-ee-agent.html
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c. Click Next. 

2. Selecting the Configuration Templates: 

a. On the Templates screen, make sure Create Domain Using Product Templates is 

selected. 

b. Select the following templates: 

 Oracle Enterprise Manager Plugin for ODI - 12.2.1.4.0 [em] 

 Oracle Data Integrator - Agent - 12.2.1.4.0 [odi] 

 Oracle Data Integrator - Console - 12.2.1.4.0 [odi] 

Note: Above selection will automatically select dependent jars. 

c. Click Next. 

3. Selecting the Application Home Location: 

a. On the Application Location screen, select the location where you want to store 

your applications associated with your domain. This location is also referred to as 

the Application home directory. 

b. Click Next. 

4. Configuring the Administrator Account: 

a. On the Administrator Account screen, specify the user name and password for the 

default WebLogic Administrator account for the domain. 

b. Click Next. 

Note: It is recommended that you make a note of the user name and password specified 

on this screen; you will need these credentials later to boot and connect to the domain's 

Administration Server. 

5. Specifying the Domain Mode and JDK: 

a. Select Production in the Domain Mode field. 

b. Select the Oracle HotSpot JDK in the JDK field. 

c. Click Next. 

6. Specifying the Datasource Configuration Type: 

a. Select RCU Data to activate the fields on this screen.  

 
The RCU Data option instructs the Configuration Wizard to connect to the database 

and Service Table (STB) schema to automatically retrieve schema information for the 

schemas needed to configure the domain.  

b. Click Get RCU Configuration when you are finished specifying the database 

connection information. 

Note: Choose Manual Configuration on this screen, you will have to manually fill in 

the parameters for your schema on the JDBC Component Schema screen. 

Note: For master and work repositories you must use ftiodimaster/ftiodiwork as 
these were created previously by the install script. The rest of the schemas are 

created in Create J2EE Agent Repositories section by the RCU. 

c. Click Next. 

7. Specifying JDBC Component Schema Information: 

a. Verify that the values on the JDBC Component Schema screen are correct for all 
schemas. If you selected RCU Data on the previous screen, the schema table should 

already be populated appropriately. 

b. Click Next. 

https://docs.oracle.com/en/middleware/lifecycle/12.2.1.4/wldcw/configuration-wizard-screensfusion-middleware-configuration-wizard-context-sensitive-help.html#GUID-E356EBB9-9EEE-47C2-ABA1-02910F05FDBA
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8. Testing the JDBC Connections: 

a. Use the JDBC Component Schema Test screen to test the datasource connections you 
have just configured. 

 

A green check mark in the Status column indicates a successful test. If you encounter 
any issues, see the error message in the Connection Result Log section of the screen, 

fix the problem, then try to test the connection again. 

b. Click Next. 

9. Specifying Supervisor Credentials 

 

Use the Credentials screen to create the following two keys: 

a. A key for the Supervisor user already exists. Modify the credential as follows: 

i. Specify SUPERVISOR (all CAPS) as the user name. This is the default name 

initially assigned to the Supervisor account and cannot be changed unless you 

create a new Supervisor account. 

ii. The password must be the same password specified on the Custom Variables 

screen in RCU during schema creation. 

b. Create a second credential as follows: 

i. Click the Plus sign (+) icon to add a new credential. 

ii. In the Key Name field, enter the name of this domain as the key. 

iii. In the Username and Password fields, provide the Administrator user's user 

name and password. 

iv. Select oracle.odi.credmap as the store name. 

c. Click Next. 

10. Selecting Advanced Configuration 

a. To complete domain configuration for the topology, select the following options on the 

Advanced Configuration screen: 

 Administration Server 
This is required to properly configure the listen address of the Administration 

Server. 

 Node Manager 

This is required to configure Node Manager. 

 Managed Server, Clusters and Coherence 

This is required to configure the Oracle Data Integrator Managed Server. 

b. Click Next. 

11. Configuring the Administration Server Listen Address 

a. On the Administration Server screen, select the drop-down list next to Listen Address 

and select the IP address on the host where the Administration Server will reside.  

b. Do not use "All Local Addresses." 

c. Do not specify any server groups for the Administration Server. 

d. Click Next. 

12. Configuring Node Manager 

 
The Node Manager screen can be used to select the type of Node Manager you want to 

configure, along with the Node Manager credentials. 

a. Select Per Domain as the Node Manager type. 

b. Specify the Node Manager credentials. 

c. Click Next. 
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13. Configuring Managed Servers 

 

On the Managed Servers screen, a new Managed Server named ODI_server1 is created: 

a. In the Listen Address drop-down list, select the IP address of the host on which 

the Managed Server will reside. 

b. Do not use "All Local Addresses". 

c. In the Server Groups drop-down list, select JRF-MAN-SVR. This server group ensures 
that the Oracle JRF services are targeted to the Managed Servers you are creating. 

 

Server groups target Fusion Middleware applications and services to one or more 
servers by mapping defined application service groups to each defined server group. A 

given application service group may be mapped to multiple server groups if needed. 

Any application services that are mapped to a given server group are automatically 
targeted to all servers that are assigned to that group.  

 

These server names and will be referenced throughout this document; if you choose 

different names be sure to replace them as needed. 

d. Click Next. 

14. Configuring a Cluster: 

 

Use the Clusters screen to create a new cluster: 

a. Click the Add button. 

b. Specify ODI_cluster1in the Cluster Name field. 

c. Leave the Cluster Address field blank. 
 

By default, server instances in a cluster communicate with one another using unicast. 

If you want to change your cluster communications to use multicast, refer to 

"Communications In a Cluster" in Administering Clusters for Oracle WebLogic Server. 

d. Click Next. 

15. Assigning the Managed Server to the Cluster 

 

Use the Assign Servers to Clusters screen to assign ODI_server1 to the new cluster 

ODI_cluster1: 

a. In the Clusters pane, select the cluster to which you want to assign the servers; in this 

case, ODI_cluster1. 

b. In the Servers pane, assign ODI_server1 to ODI_cluster1 by doing one of the 

following: 

i. Click once on ODI_server1 to select it. 

ii. Then click on the right arrow to move it beneath the selected cluster 

(ODI_cluster1) in the Clusters pane. 

iii. Double-click on ODI_server1 to move it beneath the selected cluster 

(ODI_cluster1) in the clusters pane. 

c. Click Next. 

16. Configuring Coherence Clusters: 

a. Use the Coherence Clusters screen to configure the Coherence cluster that is 

automatically added to the domain.  

b. Leave the default port number 0 as the Coherence cluster listen port. 

c. Click Next. 

https://docs.oracle.com/en/middleware/fusion-middleware/weblogic-server/12.2.1.4/clust/features.html#GUID-A0F3CCDD-B502-47E7-B72A-
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17. Creating a New Machine: 

 

Use the Machines screen to create a new machine in the domain. A machine is required in 

order for the Node Manager to be able to start and stop the servers. 

a. Click the Add button to create a new machine. 

b. Specify ODI_machine1 in the Name field. 

c. In the Node Manager Listen Address field, select the IP address of the machine 
where the Managed Servers are being configured. 

 

You must select a specific interface and not "localhost." This allows Coherence cluster 

addresses to be dynamically calculated. 

d. Verify the port in the Node Manager Listen Port field. 

e. Click Next. 

18. Assigning Servers to Machines:  

 

Use the Assign Servers to Machines screen to assign the Administration Server and Managed 

Server to the new machine you just created: 

a. In the Machines pane, select the machine to which you want to assign the servers; in 

this case, ODI_machine1. 

b. In the Servers pane, assign AdminServer to ODI_machine1 by doing one of the 

following: 

i. Click once on AdminServer to select it. 

ii. Then click on the right arrow to move it beneath the selected machine 

(ODI_machine1) in the Machines pane. 

iii. Double-click on AdminServer to move it beneath the selected machine 

(ODI_machine1) in the Machines pane. 

c. Repeat to assign ODI_server1 to ODI_machine1. 

d. Click Next. 

19. Reviewing Your Configuration Specifications and Configuring the Domain: 

 
The Configuration Summary screen contains the detailed configuration information for the 

domain you are about to create. Review the details of each item on the screen and verify that 

the information is correct. 

a. You can go back to any previous screen if you need to make any changes, either by 

using the Back button or by selecting the screen in the navigation pane. 

b. Domain creation will not begin until you click Create. 

20. Writing Down Your Domain Home and Administration Server URL: 

 

The Configuration Success screen will show the Domain home location and URL of the 

Administration Server you just configured. 

a. You must make a note of both items as you will need them to start the servers in your 

domain. 

b. Click Finish to dismiss the configuration wizard. 

Note for Windows: 

 Set the environment variable MW_HOME for middleware home, if not set.  
 

For example, MW_HOME=C:\ODI\ODI_Home. 

Note for Linux: 

Set the MW_HOME variable to the appropriate path depending on shell. 
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setenv MW_HOME  /opt/ODI/ODI_Home (csh) 

export MW_HOME=/opt/ODI/ODI_HOME(bash) 

MW_HOME value should be set for all future sessions. 

echo ’setenv MW_HOME  /opt/ODI/ODI_Home (csh) ' >>~/.tcshrc(for csh) 

Please note that this command will be different for different shells. 

Creating a Java EE Agent in the Master Repository Using ODI Studio 

Starting the Oracle Data Integrator Agent 

To start the Oracle Data Integrator agent, complete the following: 

1. In ODI Studio, go to the Topology Tab > Physical Architecture. 

2. Expand Agents. 

3. Double click on OracleDIAgent. 

4. Enter Host and Port save it.  

Note: Host is machine name/IP Address of machine where you installed ODI Weblogic. 

Note: If ODI is installed with OBIEE or OTM in the same server, then run the following 

command before starting the ODI services: 

unset CLASSPATH 

Starting the Node Manager 

1. Go to the <ODI_HOME>/user_projects/domains/<odi_domain>/bin directory. 

a. On UNIX operating systems, start the Node Manager as shown below, using nohup and 

nm.out as an example output file: 

nohup ./startNodeManager.sh > nm.out& 

b. On Windows operating systems, run: 

startNodeManager.cmd 

Starting the Administration Server 

1. To start the Administration Server, go to the DOMAIN_HOME/bin directory. 

a. On UNIX operating systems, run: 

./startWebLogic.sh 

b. On Windows operating systems, run: 

startWebLogic.cmd 

Starting the Managed Server 

1. To start the Managed Server, go to the DOMAIN_HOME/bin directory. 

a. On UNIX operating systems, run: 

./startManagedWeblogic.sh <ODI_server1> <weblogichost>:<port> 

b. On Windows operating systems, run: 
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startManagedWebLogic.cmd <ODI_server1> <weblogichost>:<port> 

Installing Oracle Business Intelligence Enterprise Edition (OBIEE) 

For detailed installation steps of OBIEE on your preferred operating system, please refer to the 
corresponding OBIEE installation documentation. 

Oracle GTI is officially certified only for OBIEE deployed using WebLogic. If you need to use a web 
application server of your choice, then please refer the OBIEE documentation for the compatibility of 
OBIEE on your choice of web application server and also for detailed deployment instructions. 

Note: All ODI users and repository names for GTI will start with “fti” and all OTM glog 

properties also contain “fti”. This is not a mistake since GTI is part of FTI. 

Installing OTM and GTI on Single Server 

OTM and Oracle FTI/GTI can be installed on the same server by following these guidelines. Skip this 
section if you choose to have OTM and FTI/GTI on different machines. 

The server machine must be a multi-homed system (two hostnames/IP addresses) which means a 
single server with two network cards. 

 Primary hostname: should contain the OBIEE install 

 Secondary hostname: should contain the OTM install 

Guidelines for Installing OTM and GTI on Single Server 

1. OTM should be brought down to unblock the default WebLogic Admin port (9500). 

2. Install OBIEE per the OBIEE installation instructions. See the Installing OBIEE section. 

Note: By default OBIEE uses the primary hostname and default port (9500) for installation. 

3. Stop OBIEE per the OBIEE installation instructions. 

4. Restart the server. 

5. Start OTM. 

6. Restart OBIEE per the OBIEE installation instructions. 

 

Creating Repository Schema Using the Repository Creation Utility 

For OBIEE 12c, schemas are created during the configuration step using Configuration Assistant. 

Installing OBIEE 

The version of OBIEE recommended for 6.4.3 GTI is OBIEE 12.2.1.4.0. 

Installing OBIEE 12c involves three major steps: 

1. Installing the Fusion Middleware Infrastructure 

2. Installing Oracle Business Intelligence binaries 

3. Configuring Oracle Business Intelligence 

http://<hostname>:7001/analytics/saw.dll?Answers 
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Installing Fusion Middleware Infrastructure 

Refer to “Installing and Configuring the Oracle Fusion Middleware Infrastructure 12c” for more 

information. You only need to install the infrastructure. Configuration is not needed at this point. 

Installing Oracle Business Intelligence Binaries 

Refer to “Installing Oracle Business Intelligence” under Fusion Middleware Installing and 

Configuring Oracle Business Intelligence 12c for complete details. 

Configuring Oracle Business Intelligence 

Refer to “Configuring Oracle Business Intelligence” under Fusion Middleware Installing and 

Configuring Oracle Business Intelligence 12c for complete details. 

Configuring OBIEE for Oracle GTI 

Note: All ODI users and repository names for GTI will start with “fti” and all OTM glog 

properties also contain “fti”. This is not a mistake since GTI is part of FTI. 

Once you successfully installed OBIEE, complete this section to deploy the Oracle GTI components 
(metadata & reports). This section also contains details on the various other configurations required in 
the OBIEE and OTM applications to complete the Oracle GTI deployment. Please perform the 
configuration steps in the following sequence: 

1. Creating RPTAPP and OLTP Database Connections 

2. Deploying metadata to OBIEE 

3. Downloading the RPD for editing 

4. Configuring GTI Metadata Repository 

5. Deploying GTI Metadata Repository to OBIEE 

Creating RPTAPP and OLTP Database Connections 

On the OBIEE server, create two new database connections with the name RPTAPP and OLTP: 

 RPTAPP should connect to the Oracle FTI/GTI historical database. 

 OLTP should connect to OTM database. 

To do this, complete the following: 

1. Open the 
<OBIEE_INSTALL_PATH>\user_projects\domains\bi\config\fmwconfig\bienv\core\tnsna

mes.ora file.  

Note: Only complete these steps in the exact tnsnames file listed above. In case the file is 

not present in the admin folder, copy it from the sample folder (admin\sample) and replace 

the information inside the tnsnames.ora file with the ones mentioned below. 

2. For a standard database connection, add the following into the tnsnames.ora file: 

RPTAPP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <FTI HD Host>)(PORT = <FTI HD Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <FTI HD SID>) 
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  ) 

) 

 

OLTP = 

(DESCRIPTION = 

  (ADDRESS_LIST = 

    (ADDRESS = (PROTOCOL = TCP)(HOST = <OTM OLTP DB Host>)(PORT = <OTM OLTP 

Port>)) 

    ) 

  (CONNECT_DATA = 

    (SID = <OTM OLTP DB SID>) 

  ) 

) 

3. For a standard database connection, update the following entries to correspond with your FTI 

configuration: 

a. Under RPTAPP, set the following: 

i. (HOST =<FTI HD Host>) should be the FTI/GTI DB server name as specified in 

numerous places: glog.database.fti.dbserver and ODI repository creation. 

ii. (SID = <FTI HD SID>) should be the FTI/GTI DB SID as specified in 

numerous places: glog.database.fti.sid and ODI repository creation. 

iii. (PORT = <FTI HD Port>) should be the FTI/GTI DB Port as specified in 

numerous places: glog.database.fti.port and ODI repository creation. 

b. Under OLTP, set the following: 

i. (HOST =<OTM OLTP DB Host>) should be the OTM DB server name as 

determined during the OTM install. 

ii. (SID = <OTM OLTP DB SID>) should be the OTM DB SID as determined during 

the OTM install. 

iii. (PORT = <OTM OLTP Port>) should be the OTM DB Port as determined during 

the OTM install. 

4. For a RAC database connection set the RPTAPP as shown below: 

RPTAPP = 

(DESCRIPTION = 

(ADDRESS = (PROTOCOL = TCP)(HOST = <RAC SCAN LISTENER ADDRESS>)(PORT = <SCAN 

LISTENER PORT NUMBER>)) 

(CONNECT_DATA =  

(SERVER = DEDICATED) 

(SERVICE_NAME = <RAC SERVICE NAME>)) 

) 

a. Under RPTAPP, set the following: 

i. (HOST =<RAC SCAN LISTENER ADDRESS>) should be the RAC SCAN listener 

address. 

ii. (PORT = <SCAN LISTENER PORT NUMBER>) should be the RAC SCAN listener 

port number. 

iii. (SERVICE_NAME = <RAC DB SERVICE NAME>) should be service name of the 

RAC database server. 

b. Set the OLTP up as detailed for a standard database connection. 

When OBIEE loads the Oracle Global Trade Intelligence metadata, it will connect to the HD and OLTP 
databases using the RPTAPP and OTLP tnsname entries only. 
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Deploying Metadata to OBIEE 

Deployment in OBIEE 12c is entirely via command line. The advanced_analytics.bar file shipped with 
FTI contains the RPD, Catalog, and security metadata bundled into bar file. The following steps can be 
used to deploy them: 

1. Navigate to <OBI_HOME>user_projects/domains/bi/bitools/bin. 

2. Run ./stop.sh to stop all servers. 

3. Start WLST from ORACLE_HOME/oracle_common/common/bin/wlst.sh. 

4. Copy the .bar file to the server where OBIEE is installed. 

5. Use the following command in WLST to import the BAR file into the new OBIEE 12c instance: 

a. importServiceInstance('/Middleware/user_projects/domains/bi','ssi','/tmp/advanced_a

nalytics.bar',true,true,true,'transportationintelligence1'). 

b. The parameters used above in order are as follows: 

i. DOMAIN_NAME – Domain configured for OBIEE 

ii. SERVICE INSTANCE – ssi by default 

iii. BAR FILE LOCATION 

iv. IMPORT RPD 

v. IMPORT CATALOG 

vi. IMPORT SECURITY MODEL 

vii. PASSWORD – transportationintelligence1 is shipped by default 

6. Once the import is done, start the serves using ./start.sh. 

 

Downloading the RPD for Editing 

The RPD needs to be downloaded for changing the schema passwords in the connection details. Please 

use the following steps to download the RPD: 

1. Navigate to <OBI_HOME>user_projects/domains/bi/bitools/bin. 

2. ./datamodel.sh downloadrpd -O advanced_analytics.rpd -SI ssi -U weblogic -P <weblogic 

password>. 

3. The downloadrpd parameter denotes that the RPD is being downloaded. 

4. –SI denotes services instance and –U, -P parameters require the weblogic username and 

password set at the time of configuration. 

5. Once executed, the command will prompt for the RPD password. This password can be any 
password that is desired. Please make a note of this password as it will be needed while 

deploying this RPD back into the system. 

Configuring GTI Metadata Repository 

Before redeploying the GTI repository file, you must configure it to connect to the FTI/GTI historical 

database and the OTM OLTP database. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

To configure these connections, complete the following: 

1. Using BI Administration Tool, open the advanced_analytics.rpd in offline mode. 
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2. In Physical Layer, expand each database definition and in each connection pool specify the 

following: 

a. HDOWNER database user’s password where HDOWNER user is set 

b. GLOGDBA database user’s password where GLOGDBA user is set 

3. Save the RPD. 

4. Select No when prompted for Global Consistency. 

 

Deploying GTI Metadata Repository to OBIEE 

In 12c, deploying the RPD is entirely via command line. Once the RPD is downloaded and the 

connection details set, the following steps can be used for deployment: 

1. FTP copy your RPD to the OBIEE server. 

2. Navigate to <OBIEE INSTALL PATH>/user_projects/domains/bi/bitools/bin. 

3. In the command line, give ./datamodel.sh uploadrpd -I advanced_analytics.rpd -SI ssi -U 

weblogic -P <weblogic password>. 

4. The datamodel.sh command is used to upload the RPD.  

5. The uploadrpd parameter denotes that the RPD is being uploaded to the system. 

6. The name of the RPD is given for the –I parameter. 

7. The default service instance name is ‘ssi’ which is given for the –SI parameter. 

8. –U and –P require the weblogic username and password to be specified (set at the time of 

configuration). 

9. While executing the command, it asks for the RPD password. The default password for the 

shipped RPD is ‘transportationintelligence1’. If changed by the customer, please use the 

changed password. 

10. Once the command is successful, the system will be now ready and no restart is needed. 

 

With this step, you have completed all the configuration steps in OBIEE. 

Note: To test if FTI is successfully configured, browse to the following URL: 
http://<obieeserver>:9502/analytics 

 

Configuring OTM for Oracle GTI 

OTM Properties 

After successfully installing and configuring ODI and OBIEE, append the following properties to the 

CUSTOM property set to configure FTI/GTI related properties in OTM: 
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Table 5-1 

Key Value Description 

aa_webserver http://myfti.my.com:7001 Specify the complete URL of the OBIEE 
server along with the port number. If 
setting up reverse proxy server (the 

recommended approach), specify the 
HTTP Server here. See Configuring the 
OTM HTTP Server’s Proxy Settings for 
more details. 

Be sure to include the http:// or 
https:// as applicable. 

As OTM does not pass through the URL 

on an internal DNS name, you will 
need to open a firewall IP and port so 
that OTM can call the external fully 
qualified domain name (FQDN). After 
the changes are made, you will need 
to restart the OTM web server. 

isAllowedGTIAnalytics true Enables/Disables the Global Trade 
Intelligence (GTI) option in Oracle 
Transportation Management 

glog.database.fti.password  Oracle GTI database password 

glog.security. 

userSession.enabled 

false To enable navigation from Oracle 

Transportation Management to GTI 
without an external single sign on 
(SSO) solution, set this property to 
"true" on the Oracle Transportation 
Management web server. 

See the Oracle Transportation 

Management Security Guide for 
complete details about enabling single 
sign on. 

glog.odi.agent.server  Host name of the server running the 
ODI agent 

glog.odi.agent.port  Port number of the server running the 

ODI agent 

glog.odi.password <SUPERVISOR password> Password of the ODI login user. Refer 
to the ODI installation documentation 
for more information on this password. 
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Key Value Description 

glog.odi.work.repository.code FTI_WORK Specify the name of the GTI work 
repository deployed in the ODI server. 
You set this up earlier in the 
installation process. 

Note: glog.odi.work.repository.code is 

the Work Repository Name that you 
specified while creating the work 
repository. 

glog.odi.email.from.address ftiadmin@yourdomain.com Specify from e-mail address to send 
ETL results. 

 

Note these properties can be set in the Custom Properties section of the glog.properties file. See 
the Custom Properties section of the Administration Guide for more information. 

Also set the following properties in the glog.properties file: 

Table 5-2 

Key Value Description 

glog.database.fti.dbserver ftihost.mycompany.co

m 

Fully qualified domain name of 

the Oracle FTI database 

glog.database.fti.port 1521 Port that Oracle is using on the 

Oracle FTI database server 

glog.database.fti.sid  Oracle FTI database service 
name 

 

Deploying Multiple RPDs in a Single OBIEE11g Installation 

This section provides instructions how to deploy two repository (RPD) files in a single installation of 
OBIEE. For complete details on the OBIEE installation, see the ORACLE® FUSION MIDDLEWARE 

INSTALLATION GUIDE FOR ORACLE BUSINESS INTELLIGENCE 11G RELEASE 1 (11.1.1), chapter 2 

Recommended Installation Scenarios for Oracle Business Intelligence. Specifically, refer to the 
sub section 2.2.3.2 Installing Multiple, Standalone Oracle Business Intelligence Instances on 

a Single Computer. 

You can establish multiple instances of OBIEE on single installation of OBIEE on the same computer. 
In this process, an additional WebLogic domain is created which establishes the connection between 
Oracle BI Home and the second instance of OBIEE. 

Pre-requisites: 

Installation of OBIEE on the machine has already been completed. As a result, you have an OBIEE 
directory, which already has an instance generated, and OracleBI Home directory. 
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Generating a Second Instance of OBIEE 

Complete the following steps to generate a second instance of OBIEE in single OBIEE installation 
directory: 

1. Create new schema using the RCU utility for the new instance. 

o Run the command rcu.bat to create the new schema. 

2. Run the batch file config.bat present in the path below to use the Configuration Assistance 

to generate another instance of OBIEE: 

o Middlewarehome > OracleBI1>bin>config.bat 

3. Click Next until you see a window to select Create New BI System. 

4. Select the Create New BI System option. 

5. Enter a different name for Domain Name.  

 

For example: bifoundation_domain2 

6. Enter the WebLogic user name and password. 

7. Click Next. 

8. Click Next again. 

9. Enter the Connect string. 

10. Enter the schema name and password created using RCU in first step for BIPLATFORM 

Schema_Username and password. 

11. Click Next. 

12. Enter the same schema name and password created using RCU in first step for 

MDS_SCHEMA. 

13. Click on Next until you see a window which contains the Configure button. 

14. Click the Configure button. 

15. Click Finish. 

Now the second instance of OBIEE is generated in the same OBIEE installation directory. To verify the 
instance was generated, go to the following path: 

 Middlewarehom > instances 

After following the above mentioned steps, the following URLs are generated to access both of the 
instances: 

Instance1     Instance2 

 http://localhost:7001/em   http://localhost:7002/em 

 http://localhost:7001/analytics      http://localhost:9704/analytics 

 http://localhost:7001/console   http://localhost:7002/console 

This allows you to utilize two individual instances of OBIEE to host two different RPDs and their 

respective web catalog files using the respective URLs for each instance. 

Note: It is recommended to open the URLs of both instances in separate browsers. 

Manually Merging GTI and OBIA 

This section details how to manually merge GTI with Oracle Business Intelligence Applications (OBIA). 

The merging process is comprised of the two steps listed below. 
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 Manually Merging OBIA Metadata with GTI Metadata 

 Manually Merging the OBIA Web Catalog with GTI Web Catalog 

Prerequisites 

The following are required prior to completing the merge process: 

 OTM is already installed. 

 GTI is installed and configured except for the OBIEE deployment which is covered in the 

section titled “Deploying GTI Metadata Repository & Web Catalog to OBIEE”. 

 OBIA is already installed on this machine. 

Manually Merging OBIA Metadata with GTI Metadata 

Important Note: Manually merging RPDs is possible. However, these changes result in a 

non-standard installation. Oracle only supports issues reported on a stand-alone GTI 

installation. Therefore, Oracle Product Support requires users to replicate any issue in a 

non-merged GTI environment prior to reporting the issue. 

Next, you need to manually merge the GTI metadata and the OBIA metadata. 

For detailed steps, refer to the section “Merging Repositories” -“Performing Full Repository Merges 

without a Common Parent” in the Oracle Business Intelligence Enterprise Edition 11g documentation. 

Note: RPDs created in a newer version of OBIEE/OBIA are not backward compatible! You 

must always merge UP to the higher version of OBIA. For example, if you have two RPDs 

and the FTI RPD is in version 11.1.1.6.8 and the OBIA RPD is version 11.1.1.7, you can 

only merge those RPDs in version 11.1.1.7. The FTI 6.3.2 RPD uses OBIEE 11.1.1.6.8. 

Note: The RPD can only be opened on a Windows machine. See the System Requirements 

and Supported Platforms for Oracle® Business Intelligence Suite Enterprise Edition > Client 

Environment Requirements. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 

Installer. It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool is only available for 

Windows. 

Prerequisites 

The following variables should be changed before starting the merge process. There are several 
objects variables that overlap between OBIA and GTI. You need to rename several duplicate variables 
for use by GTI as shown below: 

1. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 
All Programs >Oracle Business Intelligence > BI Administration 

 

OR 
 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

2. Open the FTI RPD using the BI Admin tool. Go to File > Open > Offline. 

3. Provide the password when prompted. 

4. Navigate to Manage > variables > Repository > Dynamic. 
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5. Locate the variables CURRENT_MONTH, CURRENT_WEEK, CURRENT_YEAR, and 

CURRENT_QUARTER. 

6. Rename these variables as shown in the table below. 

Table 5-3 

Sequence 
Number 

Object Type Object Description 

1 Repository 
Variable 

CURRENT_MONTH There is a conflict with the 
CURRENT_MONTH object in the FTI/GTI RPD 
and the identically named variable is in the 
OBIA RPD. You must rename the FTI/FTI 
variable to end with FTI 
(CURRENT_MONTH_FTI). 

2 Repository 
Variable 

CURRENT_WEEK There is a conflict with the CURRENT_WEEK 
object in the FTI/GTI RPD and the identically 
named variable is in the OBIA RPD. You 
must rename the FTI/FTI variable to end 
with FTI (CURRENT_WEEK_FTI). 

3 Repository 
Variable 

CURRENT_QUARTER There is a conflict with the 
CURRENT_QUARTER object in the FTI/GTI 
RPD and the identically named variable is in 
the OBIA RPD. You must rename the FTI/FTI 
variable to end with FTI 
(CURRENT_QUARTER_FTI). 

4 Repository 
Variable 

CURRENT_YEAR There is a conflict with the CURRENT_YEAR 
object in the FTI/GTI RPD and the identically 

named variable is in the OBIA RPD. You 
must rename the FTI/FTI variable to end 
with FTI (CURRENT_YEAR_FTI). 

7. Save and close the FTI RPD. 

8. Open the OBIA RPD. 

9. Navigate to Manage-Variables > Session > Variables > System. 

10. Locate the variables USER and loglevel. 

11. Delete both variables. 

Table 5-3 

Sequence 

Number 

Object Type Object Description 

5 Session Variable LOGLEVEL LOGLEVEL has conflicts, OBIA log level has been 
removed 

6 Session Variable USER USER has conflicts, OBIA USER has been removed 

 

Note: If you have edited the OBIA RPD to Authenticate and Authorize the users then follow 

these additional steps: 
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12. IF OBIA is using the external table authentication mechanism: 

a. Update the initialization block in Manage > Variables > session > Initialization blocks 

> Authenticate. 

b. Change the query so that the user is authenticated for both FTI/GTI and OBIA. 

13. IF OBIA is using ‘ROLES’ variable from RPD to get the ‘ROLES’: 

a. Change the initialization block in Manage > Variables > session > Initialization blocks 

> GET_USER_ROLE.  

b. Changes the query so that the ROLES get assigned for both FTI/GTI and OBIA. 

Running the Merge Repository Wizard: 

Now, you are ready to run the Merge Repository wizard as follow: 

1. If using a Linux/Unix machine, you must first copy 

<otm_install_path>/fti/advanced_analytics.rpd to the Windows system where the BI 

Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA RPD or Customer-defined RPD to 

the Windows system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA RPD or Customer-defined RPD, please contact your 

OBIEE/OBIA administrator. 

3. Open the BI Administration tool: 

a. If OBIA is installed on a Windows machine the executable is located either at: 

 

All Programs >Oracle Business Intelligence > BI Administration 
 

OR 

 

OBIEE_HOME\Oracle_BI1\bifoundation\server\bin\AdminTool.exe. 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the BI Administration tool installed and open the BI Administration tool. 

4. Create a new blank repository which will be used during the merge process: 

a. Create a new repository with no contents. 

b. Save it as blank.RPD in a folder. 

5. Open the OBIA RPD via File >Open.  

6. Navigate to File > Merge.  

 

The Merge Repository Wizard opens. 

7. In the Merge Repository Wizard, choose the following options: 

a. Select a Merge Type: of Full Repository Merge. 

b. For Original Master Repository:, select the newly created blank.rpd. 

c. For Modified Repository:, choose the FTI/GTI RPD which is titled 

advanced_analytics.rpd. 

d. For Current Repository:, choose the OBIA RPD. 

e. Save the Merged Repository with the name merged rpd. 

8. Click Next. 

9. In the Decision field choose all the Decisions to be current. 

a. Selecting Current keeps the object from the current repository. This is what you must 

select. 

b. If you select Modified, objects are deleted. You should NOT select Modified. 
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10. Click finish. 

Note: After completing the merge, you may notice that not all components in OBIA RPD 
have transferred to the merged RPD but all components of FTI/GTI RPD have transferred. 

There may be empty folders in physical layer that are not being transferred to the merged 

metadata. You can ignore these empty folders they will have no impact on the reports. 

Manually Merging the OBIA Web Catalog with GTI Web Catalog 

In this procedure, the OBIA dashboards and reports are merged with the FTI/GTI dashboards and 
reports. 

On a Windows machine, download and install Oracle Business Intelligence Developer Client Tools 
Installer. It is available for download from the Oracle Technology Network. 

Note: This must be a Windows system since the BI Administration tool and Catalog 

Manager is only available for Windows. 

Merging the FTI and OBIA Web Catalogs 

1. If using a Linux/Unix machine, you must first copy <otm_install_path>/fti/aa which is the 

FTI/GTI web catalog to the Windows system where the BI Administration tool is installed. 

2. If using a Linux/Unix machine, you must also copy OBIA web catalog to the Windows 

system where the BI Administration tool is installed.  

Note: For the exact name of the OBIA web catalog, please contact your OBIEE/OBIA 

administrator. 

3. Open the Catalog Manager: 

a. Windows ONLY: Open the catalog manager in windows by running either of the 

following: 

 

All Programs ->Oracle Business Intelligence -> Catalog Manager 
 

OR 

 
OBIEE_HOME\instances\instance\bifoundation\ 

OracleBIPresentationServicesComponent\ 

coreapplication_obips1\catalogmanager\runcat.cmd 

b. If OBIA is installed on a linux machine, then switch to a Windows machine which has 

the Catalog Manager installed and open the Catalog Manager. 

4. Select File > Open catalog. 

5. Open the OBIA web catalog in offline mode. 

6. Open another window of Catalog Manager. 

7. Open the FTI web catalog, aa, in the new window. 

8. Copy the shared folder from the FTI web catalog, aa. 

9. Paste it into the OBIA web catalog. 

Note: After pasting the shared folder in the OBIA Catalog in the Catalog Manager window, 

an error alert appears with no description. If you click on details button, it shows as 

a“java.lang.NullPointerException” error. You can ignore this error. No errors are seen in 

end reports due to this error. 
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Deploying the New OBIA Web Catalog 

1. Linux Only: Copy the newly merged web catalog back to your linux system so that you can 

load the new catalog. 

2. Load the merged catalog in OBIEE server as follows: 

a. Open WebLogic Enterprise Manager (http:<weblogic_host>:<port>/em). 

b. Navigate to Business Intelligence > Coreapplication > deployment > 

Repository > Catalog Location. 

c. Provide the location of the merged OBIA web catalog. 

d. Restart the WebLogic server. 

Note: Refer the following document to restart the WebLogic server “Oracle® Fusion 
Middleware System Administrator's Guide for Oracle Business Intelligence Enterprise 

Edition11g Release 1 (11.1.1)” section 4 Starting and Stopping Oracle Business 

Intelligence. 

Updating the GTI Prompts with New Variables 

Finally, you need to change the GTI prompts which have the older variables CURRENT_MONTH, 
CURRENT_WEEK, CURRENT_QUARTER, and CURRENT_YEAR to use the new prompts of 
CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, and CURRENT_YEAR_FTI as 
defined in the RPD. 

1. Open OBIEE Analytics using the URL http://<obiee_host>:<port>/analytics. 

2. Navigate to Catalog > Shared Folders > GTI Dashboard Prompts. 

3. Edit the following dashboard prompts and change the default variables given there to the FTI 

specific variables of CURRENT_MONTH_FTI, CURRENT_WEEK_FTI, CURRENT_QUARTER_FTI, 

and CURRENT_YEAR_FTI. 

a. /shared/GTI Dashboard Prompts/Export_GTI Period Prompt 

b. /shared/GTI Dashboard Prompts/Import_GTI Period Prompt 

 

Creating New GTI Reports 

It is recommended that you create any new GTI reports by opening the Ad Hoc Query link (Global 

Trade Intelligence > Ad Hoc Query) in a new window. This will allow all OBIEE features to work 
properly.  

The other recommendation is to set up a reverse proxy in OTM/GTM HTTP Server for OBIEE WebLogic 
server as follows. 

Configuring the OTM/GTM HTTP Server's Proxy Settings: 

1. Open OTM/GTM HTTP Server's mod_wl_ohs.conf file. 

2. Insert the following proxy request information into the configuration file: 

 ProxyRequest Off 

 <Proxy*> 

   Order deny,allow 

   Allow from all 

 </Proxy*> 

 Location/Oracle BI EE subdirectory 

   ProxyPass http://location of Oracle BI EE server/ 

      Oracle BI EE subdirectory 

   ProxyPassReverse http://location of Oracle BI EE server/ 
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      Oracle BI EE subdirectory 

 /Location 

3. Save and close the configuration file. 

4. Test the configuration by using a fully-qualified name to log into Oracle's OBIEE through 

Oracle HTTP Server. 

 

Installing Other Languages for Oracle GTI 

The translated file for GTI metadata and reports are available as part of an update to 6.3 and use the 
steps documented in the “Installing Other Languages for Oracle FTI”.
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6. Database Administration 

The contents of this chapter represent our recommendations rather than requirements. When making 
any changes to an OTM database, the DBA should always consider the size and the activity pattern of 

the database, the hardware configurations, and business requirements. 

Initial Setup of Oracle Database 

Initial Parameters 

OTM provides a sample init.ora file with recommended values of some key parameters. These values 
may need to be adjusted according to available physical memory on the database server. As rule of 
thumb, the System Global Area (SGA), or the shared memory of a database, should always be 
allocated in the physical memory for fast data access. If SGA is too large and swapped to disk paging 

will occur. Paging usually overweighs the advantage of having a large SGA. We recommend the 
following values for some of initial parameters. 

DB_BLOCK_SIZE 

8192  

 

DB_16K_CACHE_SIZE 

104857600 (at least 100 MB) 

 

SHARED_SERVERS 

0 

 

 

JOB_QUEUE_PROCESS 

4(This is mandatory minimum value since OTM database uses scheduled jobs). 

 

LOG_CHECKPOINT_INTERVAL 

Do not set this parameter if FAST_START_MTTR_TARGET is set. Otherwise set it to 

0 or infinity. 

 

processes = 3000 

# This number affect the number of connections to the database. 

OPEN_CURSORS 

3000 

 

SESSION_CACHED_CURSORS 

100 

 

 

MEMORY_TARGET = 8G 

# MEMORY_TARGET specifies the Oracle system-wide usable memory. The database 

tunes memory to the MEMORY_TARGET value, reducing or enlarging the SGA and PGA 

as needed. 

 

cursor_sharing = FORCE 

# Allows the creation of a new cursor if sharing an existing cursor, or if the 

cursor plan is not optimal. 

 

OPTIMIZER_INDEX_COST_ADJ  

50 

Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH 

JOIN. 
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OPTIMIZER_INDEX_CACHING 

50 

Setting this parameter to encourage optimizer to favor NESTED LOOP over HASH 

JOIN. 

 

STATISTICS_LEVEL 

TYPICAL 

 

query_rewrite_enabled    

true 

For using function based index. 

 

query_rewrite_integrity   

trusted 

For using function based index. 

 

Using Locally Managed Tablespaces 

Oracle Database recommends using locally managed tablespaces for all of OTM tablespaces, including 
SYSTEM tablespace. Locally managed tablespaces can improve performance by eliminating some 
recursive operations during space allocation. 

Initial Redo Log Files  

It is recommended to have three, four, or five redo log groups. Each group should have at least two 
members. We recommend that the initial size of the redo log files be 10 – 20 MB. Once the database 
is in normal operation, especially for a production database, the DBA should monitor the log switch 

frequency. If log switch occurs too often; for example, less than 10 minutes, the size of redo log files 
should be increased. 

Initial Setting of Undo 

Historically, Oracle Database has used rollback segments to manage undo. Space management for 
these rollback segments has proved to be quite complex. In 9i and later, the Oracle Database provides 
UNDO tablespace, another way to manage undoes, UNDO_MANAGEMENT=AUTO. Using this method 
DBAs do not have to deal with the complexities of managing rollback segment space and can exert 
control over how long undo is retained before being overwritten. This is the recommended method for 

OTM. 

If you decide using manual UNDO management you should set up your rollback segments following 
the guideline below. Rollback segments should be designed adequately to reduce contention and 
prevent “snapshot too old” errors. Most of the transactions of an OTM database are small and of OLTP 
type. The number of rollback segments is determined by the number of concurrent transactions in the 

database. For initial settings, the number of rollback segment should be set to at least four. Each 
rollback segments also should have equal size of INITIAL and NEXT extents with MINEXTENTS equals 

to ten. The INITIAL and NEXT extent size can be set to 2 MB. The DBA should periodically monitor the 
rollback segment usage and adjust setting or add new segments, if needed. 

Initial Setup of OTM Database 

There are several schema owners/users and database roles that need to be created in the database. 
Running create_glog_users.sql will get these roles and users created. Most of OTM database objects 
are under schema GLOGOWNER. OTM database object types include, but not limited to: 

TABLE 
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TABLE PARTITION 

INDEX 

INDEX PARTITION 

LOB 

LOB SUBPARTITION 

SEQUENCE 

TRIGGER 

VIEW 

PACKAGE 

PACKAGE BODY 

PROCEDURE 

FUNCTION 

JAVA CLASS 

JAVA SOURCE 

 QUEUE 

 TYPE 

Each OTM application table has a primary key. There are many foreign keys in OTM database to 
guarantee data integrity. Certain database maintenance work such as import may cause foreign keys 
“NOT VALIDATED”. The DBA should make sure the status of the foreign keys are “ENABLED” and 
“VALIDATED”. 

Each application table also has a footprint trigger that populates footprint columns of the table. All of 
the triggers should be “ENABLED”. 

Analyzing Tables/Gathering Statistics 

It is very important that the OTM database tables are analyzed properly. Please refer to the section of 
the Administration Guide titled “Analyzing Tables/Gathering Statistics” for more details. 

Real Application Clusters (RAC) 

OTM may be used in conjunction with Oracle Real Application Clusters. Please refer to the section 
titled “Real Application Clusters (RAC)” in the Administration Guide for more details on how to do that. 
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7. Integrating with Oracle E-Business Suite Financials 

Prior to OTM 6.3.1, OTM had two BPEL processes to perform OTM Voucher to EBS AP Invoices 
Integration. These processes were specific to 10g servers. With OTM 6.3.1, 11g servers are an option, 

so two composites were added to facilitate integration using an 11g server. The integration process is 
to transform an OTM Voucher into an EBS AP Invoice and then directly save it into the EBS database 
without EBS processing the transaction. 

The zip files containing the source code for the processes are found in the utils/integration/bpel/flows 
folder. The utils folder is in the root directory of the OTM installation. Before you deploy to the server, 
read the readme file found in the OtmVoucherToOracleApInvoice_11g.zip file, in the zipped folder: 

OtmVoucherToOracleApInvoice\deploy\README.txt. 

For more information see My Oracle Support document 1546441.1: How to Integrate Oracle 
Transportation Management with Oracle E-Business Suite Financials. 

For a complete list of My Oracle Support documents dealing with OTM-EBS integrations, see 
1546042.1: Integrating Oracle E-Business Suite with Oracle Transportation Management. 
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8. Appendix: General Properties 

See the “Advanced Configuration: Custom Properties” chapter in the Administration Guide for 
instructions on how to manage reserved properties. 

Table 8-1 

Property Reserv

ed 

Description 

glog.database.ftioci.TNSName Yes Specify the Fusion Transportation Intelligence/Global 
Trade Intelligence database DB connection string: 

jdbc:oracle:thin:@$ 
glog.database.fti.dbserver$:$glog.database.fti.port$ 

glog.database.ftioci.database Yes Specify the database SID for the Fusion 
Transportation Intelligence/Global Trade Intelligence 
server. 

glog.database.ftioci.dbserver Yes Specify the fully qualified domain name of the Oracle 
Fusion Transportation Intelligence/Global Trade 

Intelligence database server (this will contain the 
HDOWNER database schema). 

glog.database.ftioci.gluser Yes Specify the Fusion Transportation Intelligence/Global 
Trade Intelligence gluser of DBA.ADMIN. 

glog.database.ftioci.password Yes Specify the password of the HDOWNER user in the 

Fusion Transportation Intelligence/Global Trade 
Intelligence database. 

glog.database.ftioci.schema Yes Specify the name of the schema hosting the Fusion 
Transportation Intelligence/Global Trade Intelligence 
database. This should typically be HDOWNER unless 
a different schema name is used. 

Example: HDOWNER 

glog.database.ftioci.server Yes Specify the Oracle Fusion Transportation 
Intelligence/Global Trade Intelligence database SID 
name. 

glog.database.ftioci.t2client.conne

ctionURL 

Yes Specify the Fusion Transportation Intelligence/Global 

Trade Intelligence database connection string: 

jdbc:oracle:thin:@$glog.database.fti.dbserver$:$glo
g.database.fti.port$ 

glog.database.ftioci.t2client.datab
aseURL 

Yes $glog.database.fti.t2client.databaseURL$/$glog.datab
ase.fti.server$ 

glog.database.ftioci.t2client.driver
ClassName 

Yes Specify the JDBC driver name. For example, 
oracle.jdbc.driver.OracleDriver 
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Property Reserv

ed 

Description 

glog.database.ftioci.user Yes Oracle Fusion Transportation Intelligence/Global 
Trade Intelligence database user name. An example 
and the default is HDOWNER. 

glog.database.ftithin.TNSName Yes Specify the Oracle Fusion Transportation 
Intelligence/Global Trade Intelligence database 
connection string: 

jdbc:oracle:thin:@$ 
glog.database.fti.dbserver$:$glog.database.fti.port$ 

glog.database.ftithin.database Yes Specify the database SID for the Fusion 

Transportation Intelligence/Global Trade Intelligence 
server. 

glog.database.ftithin.dbserver Yes Specify the fully qualified domain name of the Oracle 
Fusion Transportation Intelligence/Global Trade 
Intelligence database server (this will contain the 

HDOWNER database schema). 

glog.database.ftithin.gluser Yes Specify the Fusion Transportation Intelligence/Global 
Trade Intelligence gluser of DBA.ADMIN. 

glog.database.ftithin.schema Yes Specify the name of the schema hosting the Fusion 
Transportation Intelligence/Global Trade Intelligence 
database. This should typically be HDOWNER unless 
a different schema name is used. 

Example: HDOWNER 

glog.database.ftithin.server Yes Specify the Oracle Fusion Transportation 
Intelligence/Global Trade Intelligence database SID 
name. 

glog.database.ftithin.t2client.conn
ectionURL 

Yes Specify the Fusion Transportation Intelligence/Global 
Trade Intelligence database connection string: 
jdbc:oracle:thin:@$glog.database.fti.dbserver$:$glo
g.database.fti.port$ 

glog.database.ftithin.t2client.data
baseURL 

Yes $glog.database.fti.t2client.databaseURL$/$glog.datab
ase.fti.server$ 

glog.database.ftithin.t2client.driv
erClassName 

Yes Specify the JDBC driver name. For example, 
oracle.jdbc.driver.OracleDriver 

glog.database.ftithin.user Yes Oracle Fusion Transportation Intelligence/Global 
Trade Intelligence database user name. An example 
and the default is HDOWNER. 

gtm.dutyTax.externalSystem.requ
estXSL 

Yes This property identifies the XSL to convert GTM's 
outbound integration XML format. 
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Property Reserv

ed 

Description 

gtm.dutyTax.externalSystem.resp
onseXSL 

Yes This property identifies the XSL to convert Descartes' 
response XML format to GTM's inbound integration 
XML format. 

gtm.lcs.transportModeImage.AIR Yes This property is used to map AIR mode with the AIR 
image shipped with GTM. 

gtm.lcs.transportModeImage.OCE
AN 

Yes This property is used to map OCEAN mode with the 
OCEAN image shipped with GTM. 

gtm.lcs.transportModeImage.VES
SEL-CO 

Yes This property is used to map VESSEL-CO mode with 
the OCEAN image shipped with GTM. 
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